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Chapter 1 – Introduction  

Video:  Introduction 

 
James:  Welcome to this Microsoft Office PowerPoint 2010 training course.  The training is 

organized or divided into four main chapters. The first of which is the PowerPoint Basics.  This 

is followed by Working with Slides, then Beyond the Basics, and finally Presenting 

Presentations.  There is also a short, final concluding chapter.  In Chapter 2 – PowerPoint Basics 

we cover Start and Exiting PowerPoint, the PowerPoint Window, the Ribbon, the Backstage, 

specifically Opening, Saving, and Closing PowerPoint Presentations.  We then cover Options.  

We then cover Views.  In Chapter 3 – Working with Slides we start out talking about and 

explaining how to Manage a Slide Appearance.  We then talk about Working with Text, 

Outlining your Presentation, Slide Management, Working with Shapes, Working with Tables, 

Using SmartArt, Using Templates, and Working with Themes.  In Chapter 4 – Beyond the 

Basics the topics covered are Using Hyperlinks, Working with ClipArt, Pictures, and 

Screenshots, Multimedia:  Audio and Video Clips, Animation, Transitions, Compare and Merge 

Presentations, Sharing between PowerPoint and other Office 2010 Applications.  In Chapter 5 – 

Presenting Presentations we talk about Using Notes, Creating Handouts, Printing, Automated or 

Self-Running Slide Shows, and how to Annotate a Presentation.  Let me conclude by introducing 

myself.  My name is James Bulmer.  I’ve had 25 years of Management Consulting and training 

experience.  I’ve worked with hundreds of Organizations on three continents.  I’m a Microsoft 

Certified Trainer.  I’ve worked with PowerPoint since the Office 2000 version.  And I’ve been 

using PowerPoint 2010 since the first Beta release.  Thank you and enjoy the training. 
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Chapter 2 – PowerPoint 2010 Basics 

Video:  Introduction to PowerPoint 2010 Basics 

 
James:  This chapter on the PowerPoint Basics covers the following topics:  Start and Exit, the 

PowerPoint Window, the Ribbon, the Backstage – specifically Open, Save, and Close, the 

PowerPoint 2010 Option, and it ends with a discussion of the Views available in PowerPoint 

2010. 
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Video:  Start and Exit 

 
James:  This topic covers the Starting and Exiting of PowerPoint 2010.  To Start PowerPoint, if 

you have a Desktop Icon, you simply double click the Icon and this will Start PowerPoint.  You 

can also use the Start Menu.  You click Start to Open the Start Menu.  You click Select All 

Programs.  You click Select Microsoft Office and then you click Microsoft PowerPoint 2010 and 

again PowerPoint 2010 will Open. You can also Start PowerPoint by double clicking a 

PowerPoint File.  Now this works regardless of whether the extensions are displayed or not.  If 

the extensions are displayed you can see them as .pptx.  If there are no extensions, you can 

simply see the File type is Microsoft PowerPoint.  If you double click a File it will open.  

PowerPoint 2010 can Open Files or Presentations created by previous versions of PowerPoint.  

In terms of Exiting PowerPoint, you can click File in the upper left hand corner of the 

PowerPoint Window and click Exit Option or you can click Close in the upper right corner of the 

PowerPoint Window.  If you have any Unsaved work, you have made changes to the 

Presentation and they have not been Saved, you will be prompted as to what you want to do with 

these Unsaved changes.  You can Save them, Don’t Save them, or if you’ve accidently Exiting 

PowerPoint you really don’t want to Exit, you simply Cancel and you are back working with 

PowerPoint and you can make the changes, Save them, do whatever you want.  So you can’t 

accidently lose Unsaved changes.  If your Presentation is up to date, there are no Unsaved 

changes, then clicking File, click Exit, or click Close will simply end the PowerPoint 

Presentation. 
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Video:  PowerPoint 2010 Window 

 
James:  This topic covers the PowerPoint Window.  The PowerPoint Window is made up of a 

number of major components or areas.  One is the Slide Pane.  This is where you will spend a 

majority of your time.  This is where you work with Slides.  There’s also a Slide Outline Pane.  

There is the PowerPoint 2010 Ribbon.  There is the Quick Access Area and down at the bottom 

is an area that contains a number of actions related to 2010 that don’t belong in other sections of 

the Window.  Let me demonstrate. 

This is the Slide Pane.  This is where the current active Slide is displayed.  This is where you 

created New Slides, Edit existing Slides, and where in this training we will show you all of the 

actions that you can take in terms of Creating and Editing Slides.  On the left hand side of the 

screen, you have the Slides and Outline Tabs Pane.  What we’re showing now is the Slides in our 

Presentation as thumbnail sketches.  We can also, if we wish, show them as Outline Format.  We 

do that by simply clicking on the Outline and this shows us our Slides in Outline Format.  We 

can actually Edit the Data in Outline Format and we will show you that in the next chapter when 

we talk about Creating Presentations.  To switch back from the Outline to Slides we simply click 

Slides.  To make a different Slide in the Slide Pane active, we simply select it on the list of Slides 

or the thumbnail of Slides and it appears in the Slide Pane.  We also have at the top of the 

Ribbon; the Ribbon is organized into Tabs.  So we have a Home Tab, an Insert Tab, a Design 

Tab, and each Tab is a container for a related set of Commands and actions and we will cover the 

Ribbon in a separate topic in this chapter.  I should also mention that the Ribbon is common to 

all of the Microsoft Office 2010 applications.  We also have the Quick Access Toolbar, which is 

shown above the Ribbon.  The first thing is we can move so that it is below the Ribbon.  We just 

Open the drop down list and select Show below the Ribbon.  We can also Add Commands or 

take away Commands from the Quick Access.  So if we want to Add Save, we would select Save 

and we now have Save.  If we decided to move it back to the top, we could Show it above the 

Ribbon.  The last portion of the PowerPoint Window is the bottom portion of the screen.  The 

first area you will note, it says click here to Add Notes.  The creation of Notes is covered in 

Chapter 5 of this training.  You will also notice that we have which Slide is active of how many 

Slides.  So it says that currently Slide 3 of 8 is active.  If we select Slide 2 then it says 2 of 8.  We 

also have the name of the Theme that is being used in this Presentation and there is a topic in a 
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next chapter that covers Themes.  We also have a number of different Views, which we will 

cover later in this particular chapter.  We also have a Slide or Zoom In or Zoom Out.  So we can 

Zoom In or Zoom Out to make the Slide take up more of the Slide Pane.  We also have the 

option to fit the Slide to the Current Window.  So if we have made it very large and we want to 

be able to see the whole Slide in the Slide Pane, we simply say Fit to the Current Window and 

the Slide is now shown in its entirety in the Slide Pane. 
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Video:  The Ribbon 

 
James:  This topic looks at the overall organization of the PowerPoint 2010 Ribbon.  The 

Commands in PowerPoint 2010 are organized into Tabs.  There is a Default set of PowerPoint 

Tabs.  There are also Contextual Tabs that appear when you select an appropriate place holder in 

the PowerPoint Presentation.  The Tabs have or are divided into Groups of related Commands.  

The specific action of the PowerPoint Tabs, Groups, and Commands are the focus of the 

remainder of this material.  This topic is just going to give an overview of how the Ribbon is 

organized.  Let me demonstrate. 

The Default Tabs in PowerPoint 2010 are Home, Insert, Design, Transitions, Animations, Slide 

Show, Review, and View.  The File Tab is a special Tab that gives access to the Backstage, 

which is covered in a separate topic in this chapter.  When I select the Tab there are a series of 

associated Groups.  So, for example, in the Home Tab there is the Clipboard Slides, Font, 

Paragraph, Drawing, and Editing Group.  You will notice that in this case the Font and Paragraph 

Groups are not accessible because the information that I have selected in the Slide cannot be 

adjusted or worked on with the Font or Paragraph Group.  If I, however, I select Text, you will 

notice that the Font and Paragraph Group are active.  Any Group that has a Dialog involved will 

have a downward pointing arrow.  What I do to see the Font capabilities is simply select the 

arrow and I get the Font capabilities.  Some of the Commands within the Group have their own 

Sub-Dialogs and in that case I can press the down arrow, select the down arrow, and in this case 

I get to see all of the Colors that are available in this particular option.  The other thing is, is that 

when I select items within the Slide, PowerPoint may display Contextual Tabs.  In this case, I 

have selected a Table and therefore I get the Design Contextual Tab and the Layout Contextual 

Tab.  If I select this Audio clip I get the Audio Tools Format Tab and the Audio Tools Playback 

Tab.  So anytime you select an item which has special capabilities or PowerPoint provides you 

with special capabilities you will see the Contextual Tabs.  The other thing that is shown here is 

a Tab which is specific to my installation of PowerPoint.  When you install certain Add-on 

software to PowerPoint, the Add-on software displays its own Tab.  In this case of my version of 

PowerPoint, it happens to be PDF Suite 2010.  The Add-on Tabs will always be to the right of 

View and between any Contextual Tabs.  So, for example, here is PDF Suite 2010, then we have 

Audio Tools, Format, and Playback.  If you want to Minimize the Ribbon, you can Minimize the 
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Ribbon and all you see is the various Tab options.  If you want to, some people like to work with 

Control keys or Keyboard Shortcuts; there is a very simple way of determining which Keyboard 

Shortcut will work with the Ribbon Minimized.  All you do is press the Alter key and you will 

notice that I have now got a letter.  If I go, for example, to Alt-R then what happens is I get all of 

the options available in the Review Tab and the various Commands that are currently active are 

shown and highlighted.  The ones that aren’t available still have letters and so, for example, if I 

wanted to Check Spelling I would simply go Alt-S.  So this is a capability that you can choose to 

use for those people who want to use Keyboard Shortcuts as opposed to having the Ribbon 

displayed.  In this case, the Ribbon is displayed and we can simply select Spelling, go to Home, 

go back to Review, Check Spelling. 
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Video:  The Backstage:  Open, Save, Close 

 
James:  This topic covers the Backstage, with specific focus on Opening, Saving, and Closing 

Presentations.  The File button displays the File Command options.  This is also referred to as the 

Backstage View.  These Commands are focused on allowing you to work with your documents 

and Presentation.  The Options item or selection of the Backstage is covered in a separate topic 

in this chapter.  The Print Command is covered in the chapter Presenting Presentations.  Let me 

demonstrate. 

Clicking the File Tab or File Command gives access to the PowerPoint 2010 Backstage.  The 

Default that is displayed when you Open up the Backstage is the information about the currently 

active Presentation.  You will always have information on Permissions, Prepare for Sharing, and 

Versions.  And you may have optional information, as in my case, since this Presentation 

contains audio and video, therefore there is information on ways to improve the media 

performance.  The Save, Save As, Open, and Close options of the Backstage are standard 

Windows commands and they operate in PowerPoint 2010 exactly the same as any other 

Window Application.  In terms of Recent, this is where we have on the left a list of the Recent 

Presentations that we have Opened and worked with.  If we want to Re-open we simply click it, 

select it in the list and PowerPoint will Open it.  On the right, we have the Recent Places that we 

have been.  We can Open a Place that we have been, if there are PowerPoint Presentations we 

will see the PowerPoint Presentation and we can Open it.  New, basically this is where we come 

when we are wanting to start a New Presentation.  The Default New is a Blank Presentation.  We 

simply select Blank, select Create, and we have a New Blank Presentation.  We also have the 

ability to start our Presentations with Templates.  The whole topic of Templates is covered in a 

special topic in Chapter 3.  We also have the access to Themes and, again, Themes are covered 

in another topic in Chapter 3.  Printing is covered in a separate topic in Chapter 5.  Save and 

Send this gives us the ability to Save and Send our Presentation.  For example, using Email, Save 

it to the web, Save to SharePoint, broadcast the Slide Show.  We can package it up for 

Presentation using a CD.  And the last is we have access to Help.  The Options are covered in a 

separate topic in this chapter.  When we are finished with the Backstage, we simply click or 

select File and the Backstage disappears and we return to our Presentation. 
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Video:  Options 

 

James:  This topic covers the PowerPoint 2010 Options.  The Options in PowerPoint 2010 are in 

the Backstage.  You select the File Command.  You select the Option option or Option 

Command.  The Options are organized into nine general Categories.  You need to know what is 

possible to accomplish with each of these Categories.  Changing an Option affects the Current 

Presentation, All Future Presentations, All Existing Presentations.  PowerPoint will work without 

you adjusting any Option.  PowerPoint may respond erratically if you adjust Options without 

understanding what you are doing.  Let me demonstrate. 

The Options for PowerPoint 2010 are accessed through the Backstage; so we click the File 

Group or the File Command.  We select the File or Backstage Options and we are given access 

to the Options in PowerPoint 2010.  What I’m going to do is go over a very high level of each of 

them so that you have an appreciation or understanding what it controls.  In your instance, you’re 

going to have to decide which ones are most appropriate for your environment.  In the case of the 

General, probably the most important is the Color Scheme.  This is the Color Scheme that is 

implemented within PowerPoint.  It has no effect on the Color used in any of the Slides you 

create.  The other one is how much you want the Screen Tip Style.  All the way from Show the 

features descriptions to if you really know what you’re doing and you don’t want to bothered, 

Don’t Show the Screen Tips.  In terms of Proofing, review carefully and decide how much you 

want PowerPoint to provide in terms of checking the Text you enter.  One that I always consider 

is if you’re going to do a lot of work in Upper Case and you don’t want Upper Case checked, 

then you can turn off Upper Case.  This is very helpful if you are going to have acronyms or 

jargons which are in Upper Case and they’re always going to turn out to be misspellings.  In 

terms of Save, consider the Auto-Recovery Time.  This is how much work you are prepared to 

lose.  Offline Editing only operates if you’re going to Edit in this Mode.  If you are not going to 

do Offline Editing then this has no effect.  The other one that you want to think about is 

Embedded Fonts.  If you’re sending a Presentation to me and you have used a special Font; if I 

Open up your Presentation and I don’t have that Font, I will not be able to see the Text that you 

entered in that Font.  So therefore you may want to Embed the Font.  The problem with 

Embedding the Font in the Presentation, it increases the size of the Presentation significantly.  So 

don’t Embed Fonts if you don’t have to, but if you do have to Embed a Font you have that 
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capability.  Language, if you are working in multiple Languages in one Presentation, then you 

need to review this particular Option.  If you are creating Presentations in multiple Language, 

make sure you review and set these Options.  And for some of you, the most important aspect of 

Languages is if you receive a Presentation from other people in other Countries, then their 

Language Options may be imposed on your Presentation.  This can be significant when you 

actually Copy part of somebody else’s Presentation into your Presentation.  You will therefore 

have the potential of a mixture of Languages.  Advanced, some of these capabilities are very 

powerful.  You’ll notice that there is a significant number of them; they don’t all fit on one 

screen.  My recommendation is that you do not make extensive changes and then return to your 

Presentation.  If you don’t like the result, you may have trouble finding exactly which Option 

you set is the problem.  So if you’re going to come here and change the Advanced Option, the 

best, safest approach is make a change, Save, see what it does.  If you don’t like it come back 

and Undo what you did before.  You can also Customize the Ribbon.  You can decide what you 

want to do with the Ribbon, what you want in the Ribbon, how you want the Ribbon to appear.  

You can also Customize the Quick Access.  You can decide, for example, that you want to Add 

something to the Quick Access or you want to Remove something from the Quick Access and 

you can also use this Option to Show the Quick Access below or above the Ribbon.  In terms of 

Add-ins, if you install an Add-in and it does not appear then come here and turn it On.  If you 

want to Remove the Display of an Add-in then do it here.  Don’t Remove, I’m not suggesting 

that you Remove the Add-in, I’m simply suggesting that you can come here and turn Off the 

Display.  For example, if I do not want my SnagIt Add-in to Display, what I’d do is I can simply 

select it here and say OK and it will not be available anymore.  You’ll notice that when I work 

with the Add-ons, when I Exit I Close the Backstage.  I can go back to the Backstage, go to 

Options, and go back to Add-ins and continue to work.  But basically when I do something in the 

Add-ins, I’m also Closing the Backstage.  The last is the Trust Center.  Changing the Trust 

Center can greatly reduce or increase the Security of your computer, its Data, Data on your 

Organizations Network, and other computers on the Network.  You need to consult your System 

Administrator or carefully consider the risks before making Trust Center changes.  This is 

potentially opening up not only PowerPoint but your computer and your Network to threats.  So 

be very careful.  When you are done with the Options, you simply click OK and you are back to 
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your Presentation and, again, if you want to go back and look at them you simply Open up the 

Backstage, click the File, click Options. 
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Video:  Different Views 

 

James:  This topic covers the Views that are available in PowerPoint 2010.  There are four 

different Viewing options available to you.  There is the Normal view, the Slide Sorter view, the 

Reading view, and finally the Slide Show view.  These four View options are available to you in 

the lower right hand corner of the PowerPoint screen.  The View Tab Presentation Views Group 

has three of the View options.  There is a special Slide Show Tab, Start Slide Show Group that 

relates specifically to the Slide Show View.  Let me demonstrate. 

The most convenient place to switch between the four standard Views of PowerPoint 2010 are at 

the lower right hand portion of the screen.  I’m going to switch to Full Screen Mode, but I will be 

careful to explain which one of the four options I’m talking about.  So right now I’m talking, first 

of all, about the Normal view.  And in the Normal view when we select a Slide in the Slide Pane 

at the side, the Slide content is displayed in the Primary Slide area of the screen and this is where 

we do our Editing, our work.  We can change the amount of the screen that is devoted to the 

Thumbnails.  The bigger the Thumbnails, the less Thumbnails we see.  The smaller the 

Thumbnails, the more we see.  So selecting any Thumbnail brings that particular Slide into the 

Slide Pane and that becomes the focus where we can work.  We also have the Notes capability of 

the Normal view and the whole aspect of creating and working with Notes is covered in a 

separate topic in Chapter 5.  The second View that I wanted to talk about is the Slide Sorter 

view.  This is the second Icon in from the left, at the bottom.  What the Slide Sorter does is it 

presents all of the Slides and our Presentation as a series of Thumbnails.  What this does is this 

allows us to move the Slides around, reorganize them.  So if we want to switch a particular Slide 

we can do that.  If we don’t like it we can move it back there.  We can also, if we select between 

any two Slides, what we can do is we can Insert a New Slide.  Once we have the New Slide 

Inserted, we can decide whether we want to move it, whereabouts we want to move it in the 

Slide Sorter view.  So the Slide Sorter allows us to Drag and Drop the Slides in total.  The next 

View that I want to talk about is the right most of the Views and that is the Slide Show view.  If I 

have this particular Slide active and I select Slide Show that is where the Slide Show starts.  If I 

wanted to end the Slide Show, I simply press Escape.  I also have the Slide Show Tab with the 

Slide Show Groups.  And basically in the Start Slide Show Group I can Start from the beginning, 

Start from the current.  I can Broadcast the Show to a web browser or I can create a Custom Play 
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of the Slide Show and we will talk more about these options in a separate topic in Chapter 5.  I 

can start the Slide Show view from either the Normal or the Slide Sorter.  So if I start the Slide 

Show here, what happens is the first Slide is displayed as I click the down arrow or I press the 

point at the down arrow at the bottom, the arrow then I move to the next Slide and I can move 

through the Slide in that way.  There also is the capability within PowerPoint to switch between 

PowerPoint and any other Open Application, which is very effective if you have another 

Application and you want to switch at the end of a Slide or in the middle of a Slide all you do is 

press Alt-Tab and what you do is you walk your way through the various Open Applications.  

So, for example, I now switched to Excel.  If I want to switch to Word, I switch to Word.  And 

you’ll notice that there are two PowerPoint Icons shown here.  One returns us to the Slide Show 

view.  The other one returns us to the Slide Show in Slide, in Normal Slide view and we can 

resume the Slide Show by clicking Resume the Slide Show.  Again, to end the Slide Show I 

simply press Escape at any point and time.  The fourth View, which is the second in from the 

right, is called the Reading view.  The Reading view is a modified version of the Slide Show 

view.  It is recommended for displaying if you want to display your Presentation not using an 

overhead projector, not over the web, you simply want to display it to people at your desk or you 

want to walk through it by yourself so you can understand it, have timings, and that type of 

thing.  And basically what you do is down at the bottom, you have two buttons; one of which is 

called Next and one of which is called Previous.  And basically what they do is, as you click 

Next, it simply walks through the next object or component of that Slide.  Here I have gone from 

one Slide to another.  If I want to go back, I simply go back and I go back to another Slide.  So 

that is the Reading Pane.  There also is a Menu of options where I can go to the Next Slide, the 

Previous Slide, to a specific Slide.  You’ll notice that if I want to go to Slide 18 directly I can do 

that.  And basically I have Slide 18.  I can also Copy Slides, Edit the Slides if I select Edit Slides 

then basically I’m back in the Normal Slide view and I can Edit.  So those are the four options 

that are available to View Data in PowerPoint 2010. 
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Chapter 3 – Working with Slides 

Video:  Introduction to Working with Slides 

 
James:  Working with Slides.  The topics in this chapter are first: Manage Slide Appearance, 

Working with Text, Outlining, Slide Management, Working with Shapes, Working with Tables, 

Using SmartArt, Using Templates, Working with Themes. 
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Video:  Manage Slide Appearance 

 
James:  Manage Slide Appearance.  Each Presentation in PowerPoint has a Slide Master.  Each 

Slide Master contains Default Formatting, other Design elements.  The Slide Master Attributes 

apply to all Slides in a Presentation.  Each Presentation has a Slide Master.  If you do not define 

one PowerPoint does it for you.  Associated with the Slide Master are several Layout Masters.  

For example, the Title Slide has a Layout Master that contains unique elements relative to the 

Titles and the Sub-Titles.  The two Column Text Layout Master has unique elements that apply 

to each Column.  By Default, there are 11 Layout Masters for each Slide Master.  The real power 

of the Slide Master is based on the fact that if you change a Slide Master element – Font, Size, 

Color, you Add a Logo – it changes all associated Layout Masters.  It is possible for you to Edit 

specific elements of a Layout Master to be different than the Slide Master.  It is possible for a 

Presentation to have multiple Slide Masters, each of which have their own set of Layout Masters.  

Regardless of the Layout Master used, that’s the starting point for a Slide, you have the ultimate 

control in your ability to Format or alter its content to meet your specific requirements.  Let me 

demonstrate. 

What I’m showing you here is a New Blank PowerPoint 2010 Presentation and what we’re going 

to do is we’re going to set the overall Slide appearance for our Presentation.  To do that we go to 

the View tab, Slide Master, and basically what we do is we can Edit the Slide Master.  Now the 

Slide Master itself is the Slide that has the number beside it.  The other Slides below it that are 

actually smaller in size are the Layout Masters.  So what we do is we go to the Slide Master.  We 

go to the Font Group of the Home Tab and what we can do is we can pick a Color.  We can make 

it Bold and we can have a Shadow.  And you’ll notice that when we do that all of the Title Styles 

in all of the Slides Layouts are of the same appearance.  So any change we make in the Slide 

Master affects the information in the Layouts that use the same information.  So, for example, we 

go to the first level for the indented Text and we’ll make it Bold.  It’s a little too big.  So let’s 

assume that we want to reduce it to about 28 point.  We look at the Bullet and we go, “Nah, we 

want a better Bullet.”  We don’t want any of the Default Bullets that are shown there so we go to 

Bullets and Numbering and then we go to Picture and basically what we do is we get a whole 

series of Pictures that we can use as Bullets in our Presentation.  So we pick one that we like and 

we go OK and we have a Bullet.  Now the other thing about Bullets that we can do is we can go 
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to Bullets and Numbering and we can adjust the Size of the Bullet relative to the Size of Text.  

This is proportional; as the Text goes bigger or smaller, this Bullet will be 90% of the Text Size.  

If we want to change the Picture, we can actually go in and change the Picture and we get a 

different Picture and there we have the way in which all of the first level hierarchical Text will 

be displayed.  For example, if we go here where we have side-by-side, you will notice that the 

first level is the same as the Slide Master.  We go to the second level.  We wanted to change it.  

We want to change the Bullet and we’ll use one of these Bullets and we’ll do the same for the 

third level.  Now, let me talk a minute about Size.  You’ll notice that we have 28 for the first 

level.  We have 28 for the second level.  So let’s make the second level smaller.  So we’ll simply 

Decrease the Font Size and it becomes 24.  Now we have 24 for the third level.  Well we want to 

make it smaller so what we’ll do is we’ll Decrease the Size, but it goes to 20.  The reason is, is if 

we Open the Point Sizes you’ll notice that it goes 28, 24, 20.  Well, we don’t have to live with 

that answer.  What we can do is we can make it 22.  And therefore we have 28, we have 24, and 

we have 22.  You can do the same for the fourth and the fifth level.  It’s entirely up to you.  Now, 

what I want to do is to show you the power of the Slide Master on your Slides.  So what I’m 

going to do is select the Slide Master tab and Close the Slide Master.  And basically, I’m going 

to and the whole next topic in this chapter is about working with Text, but what I want to do is 

very quickly just say, “This is a Title”.  I go and select a New Slide and you’ll notice that I get 

one in which I have a hierarchical Bulleted list.  So I say, “This is a Title” and I go “This is Point 

1”, “This is Point 2”.  And I create a Presentation and after two or after 22 Slides, it doesn’t 

matter, I decide that I don’t like the Layout.  So what I do is I go back to View.  I go Slide 

Master and what I do is I go to the Slide Master and I select the Title and we wouldn’t make a lot 

of changes, but we’ll just change the Color.  Let’s go from red to blue.  And basically when I do 

that and I go Slide Master, Close the Slide, you will notice that the Title has changed and the 

Title of the Slide has changed.  And so what I do is I Insert a New Slide and I say, “This is a 

Title” and “This is Text”, and I go Yes. But I don’t like blue for this particular topic that I want.  

So what I do is I make it green.  And I don’t like the Text Default Style, so what I do is I make it 

red.  And I go off and I work on my Presentation and all of a sudden I decide that I don’t like the 

overall Slide Layout so I go View, Master Views Group, Slide Master, and I go to the Slide 

Master Style and what I do is we’ll change it so that it is purple. And I go down and I can make 

other changes, but all I want to do is to illustrate a point.  So I go to Slide Master, Close Slide 



Learn PowerPoint 2010 
 

© Copyright 2008-2012 Simon Sez IT, LLC. All Rights Reserved. 
 

Master, and you’ll notice that this now has a purple Title, this has a purple Title, and the Title 

that I specifically Coded in terms of Color has not changed.  So that’s one of the things to be 

very careful of is when you’re creating Slides, if you go and use a Formatting that is not the Slide 

Master, then changing the Slide Master will not change that particular Slide or Slides.  Going 

back to the Slide Master, it is possible to go to individual Layouts within the Slide Master and to 

Edit them so that they are different than the Slide Master.  So here is side-by-side content and we 

look at it and we go we don’t like that particular Bullet Style so what we do is we can choose a 

different Bullet Style for just that particular Layout within the Slide Master.  So therefore this 

has no effect on this particular Slide.  It only has an effect on this Slide.  So we can actually go 

through and change the information on any one of the Layouts so that it is different than the 

Slide Master.  The other part of the Slide Master that you need to think about is the Footer 

information.  Now this is not whether you want to Add a Footer to the Slide, this is if you are 

going to have a Footer, how do you want it to look?  And so what we do is we go to the Slide 

Master and you’ll notice that down at the bottom we have a Date area, a Footer, and a Page 

Number.  First point is you don’t have to live with the way or what is given.  So what we decide 

to do is to Remove the Date.  We simply select the Date and we Remove it.  We want the Footer 

information to be more to the left and we select the Footer and we can Format it.  And just so 

you can see what it’s going to be like, I will use red so that it will stand out.  And therefore we’re 

going to have a Footer that’s there.  We can move the Page Number in.  You can decide whether 

you want large Page Numbers or small Page Numbers.  Again, I will just make them large and 

red and therefore we have, oops.  I did not change the Color.  I have to Apply the Color and 

therefore we have the Footer to the left, the Page Number to the right.  Now again, this does not 

apply the Footer to the Slides.  So we’ll go Slide Master, Close Slides, and you’ll notice that our 

Slides do not have Footers.  In the next topic on Managing and Working with Text we will talk 

about the insertion of Footers.  The last point that I want to make on the Slide Master is the 

ability for us to actually have multiple Slide Masters in one set of Slides.  So what we do is we 

go and right click on the Slide Master.  We go Insert a Slide Master and you’ll notice that we’re 

back to a Default Slide Master.  This one happens to be Number 2 and we can go through the 

whole process all over again and we can create an entirely second set of Slide Masters and 

associated Layout Masters within one Presentation.  And again, we have totally the same 

capability as we had before in terms of what we’re going to do in the way in which the 
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information is presented to us.  The Slide Master is a very important feature of PowerPoint and 

what you should do is be comfortable with it before you start to actually create your Slides. 
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Video:  Working with Text 

 
James:  Working with Text.  Entering and manipulating Text is a major part of the building of 

most PowerPoint Presentations.  Text is much more than Titles and Bulleted Lists.  It can be 

captions on Pictures, specialized Table Data.  It can be Formatted differently to stand out from 

the other Text.  It can be Formatted differently to blend into the background.  There is also a 

special form of Text called WordArt.  There are special Text Formatting like the Title and this 

point.  It can even be displayed Vertically.  Let me demonstrate. 

This is a New Blank Presentation.  I have Formatted the Slide Master and the associated Layout 

Masters as described in the previous topic.  In this topic, we’re going to concentrate on the entry 

of Slides, selecting the Slide Layouts, and entering Text.  So let’s assume that what we want to 

do is to say, “This is a Presentation on Presentations”.  You’ll notice that the first thing is, is that 

the Text as we type it in the Title and all of the Text areas wraps around when it is outside or too 

big to fit within the Placeholder.  This is called a Placeholder.  And this is the Placeholder for the 

Title and this is the Placeholder for the Sub-Title.  So, “This is a sub-title”, and you’ll notice that 

it fits well.  Now, we first of all, can change the Size of a Placeholder.  So what we can do is we 

can do this and we can do this.  But there are some capabilities that PowerPoint gives us that 

really make working with Placeholders and Text and that very effective.  And that is in the View 

Tab under the Show Group, what we can do is we can Show the Ruler at the top so we know 

where we are.  Okay.  And my personal favorite is the Grid Lines.  So, therefore, we have Grid 

Lines that are shown.  And we can also turn On the Guides and what they do is they help us with 

the relative position.  So here is a Guide.  If we want to make sure that all of our Titles or 

whatever it is start at 2.5 inches we simply move it to there.  It is set at zero.  You will notice that 

the Rulers go from zero up and zero down, zero left and zero right, and so therefore, we can 

make sure that this altered Placeholder fits simply by moving it so that the Placeholder Handles 

are in the zero position line.  We can change the Size by grabbing it this way or this way.  We 

can alter it in one direction.  You’ll notice that when we do an alteration in one direction we 

move it away from our original intended so we can simply move the Placeholder back.  So, turn 

On the Ruler, turn on the Grid Lines, and turn On the Guides.  This makes your life a lot easier.  

We want a New Slide.  So we go Home and we go New Slide. Now, by Default the second Slide 

in a Presentation is a standard Layout with Content.  As we go through and Add New Slides, 
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they always are of the same appearance or Format as the previous Slide.  But what we can do is 

we can actually decide anytime we Insert a Slide what Layout we want and we do that using the 

Home Tab Slides Group Layout and here is a List of all of the Layouts, based on the Layout 

Masters that are currently available to us. So we have a Title and Content.  We have a Section 

Header.  If we want to have Sections within our Presentation we can have Section Headers.  We 

can have Title with Two Content and we can have Title with Comparison; we can have Title 

Only; we have Content with Caption; we have Picture with Caption, and those are the basic ones 

that we can use.  All right?  So we can, we’ll leave this one as Title and Content and we’ll look at 

the others as we go forward.  So basically what we do is we say, “This is a Title”.  And one of 

the things that we can do is we can then go down and we can say, “This is a major point”.  This 

is another major point.  And we can go, “This is a sub-point”.  And we go uh-oh, what we want 

to do is we want to Indent this one underneath “This is another major point”.  So we can go up to 

the Paragraph area and what we can do is we can Indent that so that it now becomes a second 

level point within our Presentation.  Anytime we Insert New Text in a Text Box it always comes 

into the Presentation or the Text Box at the same level as the preceding Text.  So we go, “This is 

a second sub-point”, and we go, “This is another major point”.  And basically when we do that 

we simply have to Out-dent it or move it to the left and it takes on the same characteristics of the 

others.  Now, if you want to you can control the information in a Paragraph.  You can, for 

example, decide exactly what the Indentation is going to be, what type of first line or Hanging 

Text you want.  You can decide the Spacing before or after the Text and you can have Single, 

One-and-a-half, Double, Exactly, or Multiple Lines.  You can decide exactly how you want the 

Indents and Spacing to work for your Text.  So basically what you do is in the Text Boxes, you 

type Texts.  Let me show you a couple of the other Text Box so you will appreciate the 

difference.  If we go up here and we say, “This is two content”.  We go, “This is a Title”, and 

down here we go, “This is one set of data”.  And we then can go and Indent and say, “This is a 

sub-point”, and we go, “This is a sub-point”.  We could go over here and we can say, “This is a 

second set of data”.  And you’ll notice that because we extended the Text beyond the 

Placeholder for that Text it actually Wrapped.  And we can go and say, “This is a sub-point”.  So 

therefore we can have two Columns of Text side-by-side where we are going to be able to 

compare and contrast the Text.  We’re going to have a New Slide, by Default again it looks like 

the immediately preceding Slide.  Another Slide Layout that we have is the Comparison.  Now 
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the difference between the Two Content and the Comparison is that the Two Content says, “This 

is a Subtitle”, and we can Center it over there and we could say, “This is another Sub-Title”, and 

we could Center it there.  And then we can go into “This is Point 1” and we can make it a Sub-

point by Indenting it, saying, “This is a sub-point”.  And say, “This is Point 1” and “This is Point 

2”.  So what we can do is, “This is the Title”.  So what we can do here is in this case what we 

have is we have a Title and what we then have are Points under the Title.  Here we simply have 

boxes and we can choose the first entry to be a Title.  So you can decide which one you want.  

Again, a New Slide; let’s look at one which is Title Only, “This is a Title”.  Title Only Slides are 

good for things like SmartArt, which we’re going to talk about later on in this chapter.  In the 

next chapter, we’re going to talk about ClipArt, Pictures, Screenshots.  You may want to have a 

Slide which has a Title and you are going to include ClipArt, Pictures, or Screenshots.  So you 

don’t want anything in terms of Text on this Slide. You have a New Slide.  The Layout is a 

Picture with Caption, and basically we will show you how to use this particular Slide in detail in 

the next chapter, in the topic Working with ClipArt, Pictures, and Screenshots.  But basically, 

“This is a Picture of Sunset”.  And we can then have some smaller Text there.  So basically, we 

can put an Icon or a Picture in the, in this particular Slide.  New Slide, Slide Layout.  We can 

have Content with Caption.  Now here we have a Slide that lends itself, again, more towards 

Pictures, ClipArt, and Screenshots.  And basically we can say, This is a Picture.  And we will 

show you how to actually Insert the Pictures, but for now we’re just setting it up to work with 

Text.  So what we’re going to do is, and then we can go down here and we can explain where we 

took the Picture of the Sunset.  New Slide, Slide Layout.  And the last one, that I want to show 

you, is we simply want to put in a Blank Slide.  One of the recommendations for effect of 

Presentations is that you end a Presentation with a Blank Slide.  The reason is, is that when you 

then are doing a Slide Show and I will very quickly switch to Slide Show, we talk about a Picture 

and we explain it all and then we go click and instead of having a big burst of light from the 

Slide Projector we’re using, the Screen Projector system what we have is a Blank Slide.  So 

basically the Blank Slide is very convenient to simply put at the end of a Presentation.  Now that 

we have covered all of the Slides, specifically the Slides and their ability to handle Text, let’s 

look some more at the entry of Text.  Now this, what I’m about to show you, applies to any 

Placeholder in which you’re typing Text.  First of all, you can actually change the Size of the 

area given over to Text by simply changing, making it bigger or smaller.  You can make it bigger 
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or smaller in both ways.  Now let’s talk about Formatting the individual pieces of Text 

separately, differently than the Slide Master.  I mentioned in the previous topic, if we do this, 

changing the Slide Master will not change this Text.  But there is lots of good reasons in a 

Presentation that once you’re comfortable with the overall Layout, the overall Text, you go back 

and you Format it.  So basically what we can do is we can select Text and we could, for example, 

make it bigger.  We could Italicize it and we could change the Color.  So you can Format the 

individual pieces of Text.  What you can do is we will do the same for a word and you’ll notice 

that we can also easily change the Case.  So, therefore, what we want to do is have Upper Case 

to really make this stand out.  So we can go through and individually Format individual pieces of 

Text.  What we can do is we can go and put on Shadow, Underline, Italicize, make this very big, 

and make it green.  We can, it go right down to the individual letter.  This also applies to Text in 

a Title.  So we can change the Color of this word in the Title.  We can make it bigger.  Any piece 

of Text that we have created, we can go and uniquely Format that particular piece of Text.  In 

addition to this form of Formatting, Microsoft’s PowerPoint has the capability for us to use what 

is called WordArt.  So we will select this particular Text.  We will go to the Contextual Tab, 

Drawing Tools Format, and you’ll notice that we have the WordArt Styles.  And so we can 

simply pick one of these or pick one of the other ones that are there.  You’ll notice that we have 

two options.  One is Apply to the selected Text.  In this case, whatever choice we make is going 

to effect the selected Text, one of which is to all of the Text in the Shape.  Now remember, in 

this case all of these points and sub-points are in a Shape.  So if we pick one of these options, all 

of them are going to change.  If we only want to change one, then the selected one, then what we 

do is we select it and then we come here.  As we hover over it, you will notice that what it does 

is it actually shows you what the Text is going to look like.  So basically what we can do is we 

can select one that we are somewhat happy with or totally happy with and we can change it.  

Now the other thing about the WordArt Styles is that there are actually three components of the 

WordArt Style and you can get access to them individually using the three options to the side of 

the WordArt Styles Group.  First of all, you can change the Fill Color.  So what we’ll do is we 

will Fill it with red.  You then can Outline it.  Okay?  So what we’ll do is we will have a dark 

blue Outline.  And lastly, what you can do is you can Add a Shadow, Reflection, a Glow, Bevel, 

3-D Rotation, or Transform.  Now some of these do not work together.  Some of them produce 

results that are very strange.  So what you have to do is you have to work on them to understand.  
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But let’s, for example, we go and we select Glow and we have a Glow on our particular Text.  

We go down here and we can go and select one word and we can select a different one and we 

can do that.  So we can go down to the individual letter in terms of WordArt Style.  Don’t be 

confused with the fact that it’s called WordArt.  It’s applicable to whatever you want.  And as I 

say, there are two major categories.  There’s Applied to the selected Text or to All Text.  The 

other thing is, is that you, if you Add WordArt and you subsequently don’t like it, what you can 

do is you can Clear it.  So we’re going to Clear it simply from this to show you what it is.  You’ll 

notice that, that removes all of the Formatting.  So our original Bolding also disappears.  So, the 

WordArt Style allows you to work with Text in any Format.  For example, we’ll go down here 

and we’ll just quickly show you.  This is one set.  We go Format.  We go to WordArt and we’ve 

done that.  We’ve gone second set of Data and we go and say it’s that.  We go down here and we 

go WordArt and you’ll notice that, in this case, what I did is I selected a WordArt Style that 

applied to the entire Text and therefore what I’ve done is all I have to do is have the cursor 

someplace in the Placeholder for the Text and I can select it.  So we can go and do WordArt, any 

Text we want in any place.  We can actually go down here and say, “This is a Title”.  And we go 

Format and we go, just to show you that we could have WordArt in a Title as well.  Let me now 

show you the, I consider it to be the ultimate Formatting capability that PowerPoint presents for 

Text.  So I have selected some Text.  I go to the Format and I go to the drop down list associated 

with the WordArt Styles Group.  And what I do is I get the capability to Format that Text in 

terms of Fill.  So I could have a Gradient Fill.  I can have Text Outlining.  I can have a Solid 

Line around the Text.  I can have an Outline Style.  I can have Width.  I can have a Shadow.  I 

can go through and minutely adjust all of the effects that are possible on the selected Text.  Now, 

one of the things that you need to be careful in terms of Text is some of the Text effects are 

applied to the entire Text in the Text Holder, not just the selected Text.  For example, you will 

notice that when I Close this I have now got everything 3-D Rotated.  Okay?  That was because 

that particular feature, that particular feature is only available, is only available to all of the Text.  

I can’t have one part of the Text different than the rest of the Text.  But other than that, basically, 

what I can do is I can go down and I can select that particular and we’ll have Solid Fill.  We’ll 

make it red to stand out, and we’ll have Text Outlining that’s black, and we’ll have a yellow 

Shadow, and basically when I’m done I simply Close.  Now, if you have room on the screen you 

will notice that as you make these changes they actually appear in the Text.  So, for example, 
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what I could do is I can say, “Well what would it look like with a green?  What would it look 

like with an orange?”  So I can actually see what I’m doing as I go through.  I want to have a 

Reflection and I do that.  So basically what I do is I can go through and see.  Now if not, what I 

can do is make the changes, Close it, and I can see what it looks like.  But remember, the 

Presentation is so people can see your Presentation.  So one of the things that you want to do, I 

suggest at least at the end of every Slide is, you go, “What’s the Slide going to look like when it 

gets presented?”  And so all you do is click and you’ll notice that my 3-D effect is still there and 

so this Slide is, needs some more work.  And so what I need to do is to select this and go down 

here and select the 3-D Rotation and say No Rotation, Close, and now I go back and there is my 

Slide.  The point I’m trying to make is, is that you have ultimate control on the Color, Style, Size 

of Text.  I think most people would agree that this is a very busy Slide and probably one that we 

would not use, but the critical issue is, is to look at your Slides in Slide Show View so that you 

can see what they are going to look like when they are going to be presented.  The last part of 

this particular topic that I want to talk to you about is the actual Insertion of Headers and Footers.  

In the previous topic on Slide Appearance, we talked about setting up the Header or the Footer 

for the Slide.  Now what we’re going to do is we’re actually going to decide what we want to do 

about the placement on a particular Slide or Slides.  To do that we go to the Insert Tab, the Text 

Group, and we say Header and Footer.  Now, you’ll notice that we have basically a little Preview 

of our Slide and it shows that what we have is the ability to Insert a Slide Number and it’s going 

to go there.  We have a Footer and what we can say is, “This is a Footer”.  Now, let me explain 

something.  If we had typed in “This is the Footer” in the Slide Master, then it would be here and 

we could use it.  What I suggested, which I think is an easier way to do it, is to simply Format 

the Footer Text and then what you do is you simply Apply it here and you’ll notice that you can 

Apply it to All.  Apply it to the Current Slide and you can say Apply it to All, but don’t Show it 

on the Title Slide.  So we’ll say, Don’t Show on the Title Slide.  Apply to All, and basically what 

we have This is the Footer and This is the Page Number.  Let’s go down to this one here and we 

can go and say, “Header and Footer” and we say “This is a different Footer”.  And we can 

simply Apply it to this Slide.  So, if you have a Presentation of I don’t know, 50, 60, hundred 

Slides, and majority of them want the same Footer, you can have the Apply All and then you go 

to individual.  If for some reason that you do not want a Page Number, then what you can do is 

you can Remove the Slide Number, Page Number.  You can Apply and it’s not there.  And you 
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now have one numbered four and one numbered six and the one in the middle that is five is, does 

not have a Slide Number or Page Number.  I refer to it as a Page Number because I think of this 

when I Print it, what is going to be shown on the Slide or the Page on which the Slide appears; if 

I Print the Slide, the Slide Presentation. 
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Video:  Outlining a Presentation 

 
James:  Outlining a Presentation.  The Chicago Manual of Style defines an Outline as a list of 

the main features of a given topic often used as a rough draft of the content of a document.  

Outlining is a powerful capability for the creation of New Presentations.  It’s also a very 

effective way to understand the Presentation created by another person.  PowerPoint has a 

special Outlining capability.  Let me demonstrate. 

This is a New Blank Presentation which was Formatted or is Formatted using the Rules in the 

Master Layout as defined in a previous topic in this chapter.  To Outline our Presentation, we 

switch in the Slides Outline Pane to Outline and basically most Presentations start with a Title.  

So we’re given a Slide with a Title and we say, “This is a Title”.  And we press Enter and the 

Slide by Default following the first Title Slide is always a Text or Title and Text Slide.  And we 

say, “This is a Slide”.  Now, we press Enter, we’re now on to the third Slide, but if we want to 

type the Outline just at the Titles we would go through and we would simply type the Titles.  If 

we want to fill in the Text on a particular Slide what we do is we simply go into the Paragraph 

Group of the Home Tab and we say Indent and what we’ve done is we have now moved and we 

say, “This is a sub” or “This is a major point”.  “This is another point”.  And if we want to now 

have a sub-point under the point, again, what we do is we simply Indent it and “This is a sub-

point”,  “This is another sub-point” and we go, “This is another point”.  And after we enter it we 

go, nope, this third sub-point should actually be a major point.  So what we can do is we can 

select it and we can Decrease the List Level or we can Out-dent it and it becomes a first level 

point in our Slide.  To move to the next Slide all we do is press Enter and then we simply Out-

dent or Decrease the List Level by one again, which turns it into a Slide and we can say, “This is 

a Slide” and we could go through.  Now, as we’re building up our Presentation in Outline Mode 

it is possible that we will know that we want Slides that are not simply Title and Text as we’ve 

been working on.  So what we do is we simply Insert a Title and Text because that was the 

previous one and then we go to Layout and we select say Content with Caption.  And so we go, 

“This is a Picture” and it fills in the Picture.  And basically when we press Enter, we get one that 

is the same.  We could go back to Title and Content or we could go to Content and we could go, 

“This is a Two Content Slide”, and then what we do is we can use this or we also have the ability 

to right mouse click and what we could do is we can Demote this Slide so that it becomes the 
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first point and then we go, “This is a major point” and “This is another point”.  And basically 

now what we want to do is we want to fill in the second content.  Now, if we Indent or move 

down a level it’s simply going to Indent it under that point.  But what we do is we hold down the 

Control key and we press Enter and you’ll notice that we’ve got this nice little two, which means 

that we’re now going to type in the second of the Content Blocks and we go, “This is the right 

content”  and we can now go, “This is another point”.  And what we can do is we can when 

we’re finished, we can go back and you’ll notice that we always get the same Slide as previous.  

In this case, if want to go back to standard Title and Content we could go back to Title and 

Content and we would be there.  Let me again just bring up the Context Menu that you get when 

you right mouse click.  So what we’ve done is we’ll notice that we can Collapse and Expand.  

We can Insert a New Slide, Delete a Slide.  We can Demote and if we Demote, that becomes a 

point under the previous one.  And we can Promote, goes back to being a Slide.  We can also 

move up or down.  We can move that Slide so that we move it up.  And we select this Slide and 

we move it down.  And basically we can move Slides within our Outline.  We can also Collapse 

or Expand the Presentation.  So what we can do is we can Collapse All and what that does is this 

shows us the Presentation at a Title level.  We can go here and we can say we want to Expand 

and basically it Expands the Slide on which we’re on.  So we can Collapse All and then we can 

go and say, Okay on this particular Slide what are we talking about?  Or we can go up here and 

we could, for example, say Expand All and it would Expand all of the Slides.  So Outlining is a 

very powerful capability to Format or to Create initial Presentations and once you have got it 

Outlined, then you can switch into Slides Mode.  You can now go back and this is Text just the 

way we talked about it in the previous topic, you can go and you can turn this into WordArt.  

You can change the Color. You can do anything that we talked about in the previous one in the 

Slide.  And when we go back to here, you will notice that in this side we cannot Format the Text.  

In the Outline Pane, we can only enter the Text.  If we want to, for some reason, in Outline Mode 

we want to deal with a specific piece of Text because we know right now what we want to do, 

we can go over to the Slide Pane.  We could go to Format and we could go and we could Format 

that one, and then we could go back over here and we could continue to build up our 

Presentation.  But the simplest way, the most effective way to use Outlining is to simply build 

the Text in the Outline and then switch to Slides and Slide View and Format the Text.  The other 

thing I should mention to you in closing and this is covered in the Printing topic of a subsequent 
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chapter; it is possible for you to Print an Outline of your Presentation.  This is very good if you 

want to show your Outline to somebody without all of the Color and all of the other information; 

you just want to show the individual Text organized by Slide. 
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Video:  Slide Management 

 
James:  Slide Management.  In this topic, we will cover navigation between Slides, Inserting a 

Slide, Move or Copy a Slide or Slides within a Presentation, Duplicate a Slide or Slides, and 

probably most powerful and most useful is using a Slide or Slides from another Presentation.  

Let me demonstrate. 

As our Presentation gets larger and larger, it becomes more important that we be able to 

affectively navigate from Slide to Slide.  One of the things that we can do in the Slides Outline 

Pane, where we see the Thumbnails, we can simply select the Thumbnail and that Slide will 

move into the Slide Pane.  If we’re in the Slide Pane and what we want to do is go up one Slide 

or down one Slide, we simply do that.  We can also Move the Slide Sorter and it will Move 

within the Slides.  My personal favorite for navigation when I want to be able to simply navigate 

and work with Slides is the Slide Sorter, and in the Slide Sorter what we can do is we can see the 

Slides.  We can also use the Scroll to navigate and we can go up here to navigate through the 

Slides.  If we want to Insert a New Slide, we can do it in Slide Sorter.  We simply pick the spot 

in the current Presentation where we want the New Slide to be and we go New Slide and we get 

a New Slide and if we want to change the Layout what we can do is change the Layout.  Now 

you’ll notice that in the Slide Sorter View, we cannot see the actual Placeholders.  So if we want 

to see the Placeholders to be sure that we have the right Slide, we can slip over to the Normal 

Slide View.  In this case, when we Insert a New Slide, we actually will be able to see the type of 

Slide that we have Inserted.  So Inserting in the Slide Sorter is okay but if you want to very 

precisely see what kind of Slide it is, you need to be in the Normal Slide View.  The real power 

of Inserting Slides is not Inserting Slides in this Presentation, but to use Slides from a previously 

developed Presentation and reuse them in this particular Presentation.  There is a special feature 

that allows us to reuse the Slides.  And basically, what we do is the easiest way to do it is to go 

into the current Presentation until we get to the point where we want to start to reuse Slides.  

Then we go into the Home Tab, Slides Category, New Slides, and we select the Reuse Slides 

option.  And basically then what we do is we have to find the particular Slide set that we want.  

So we can browse.  In this case, we will Browse and we happen to have a Presentation called 

Presentation Check List.  We’ve used it before; we want to use it in this Presentation so we select 

it and we Open it.  And now what we can do is we can start to Copy the Slides from the other 
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Presentation into the existing Presentation.  The one thing that we need to be aware of is what we 

want to do with the Source Formatting.  We can either keep it or not keep it.  If we don’t keep it 

then the Formatting that’s in place in the current Slide Show, the Slide Presentation using the 

Slide Master will be the one that will be utilized.  We’ll show you both ways.  The other thing 

that the Reuse Slides do is, is that it makes it easy when you hover over to actually see what the 

content is.  So therefore what you can do is you can go: Ah that’s the one I want, and what you 

can do is you can say Insert the Slide.  Now we didn’t keep the Source Formatting so when we 

go over here you’ll notice that it is using the Current Slide Master Formatting as opposed to the 

Reused one.  We’ll go down and we will say Keep it and we will go here and we will say Insert 

the Slide and we will Insert it.  And you’ll notice that we kept the Formatting because it’s got a 

red Title in a different Format.  Now the other thing is, is that we can also do the same thing in 

Slide Sorter View.  So in Slide Sorter View we go here and let’s say that we want to Insert all of 

the Slides, and so therefore we Inserted all of the Slides from this Presentation into our Current 

Presentation.  We have the capability of going and Browsing and finding another Presentation 

and bringing some or all of the Slides in.  We can do that three, four, there’s no end to our ability 

to Reuse Slides from previous Presentations.  When we get the basic Presentation created then, 

again, this is where I find the Slide Sorter to be effective.  What we can do is we can go: Well, 

we really don’t want that.  So what we’ll do is we’ll Delete it.  We want this one. And we want 

those four and we will Cut them.  And we’ll Move them down here and we’ll Paste them.  So 

therefore what we can do is we can Cut and Paste within the Slide Sorter View.  Now, we can 

Cut and Paste in the Slide, Normal Slide view.  And again all we do is select the Slides we want 

and, in this case, we’ll Copy them.  And just to show you what happens we’ll go down to the 

very bottom and we will go Paste.  And basically we got the Slides Pasted at the bottom.  So we 

have lots of capabilities.  One other one that I want to show you is if we have a Slide and we 

want to Duplicate that Slide, all we have to do is right mouse click and we go Duplicate the Slide 

and we get a perfect Duplicate of the Slide.  And what we can then do is we can Move it around 

in the Slides and Outline Pane and place it exactly where we want in the Current Presentation.  

So in summary there are lots of capabilities to Move, Duplicate, Copy Slides within a 

Presentation.  To me the biggest take-away from this topic is the ease at which you can reuse 

Slides from other Presentations.  So as you build up a library of Presentations, you can simply 

Copy and Paste from one Presentation to another and remember you have total control as to use 
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the Source Format of the Presentation or the current Presentation you’re working on impose its 

Format on the Imported or Reused material. 
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Video:  Working with Shapes 

 
James:  Working with Shape1s.  In addition to Text PowerPoint allows you to add Shapes to 

your Slides.  It has a library of canned Shapes.  You can Draw Shapes.  You can type Text into 

Shapes.  But the most powerful capability is that PowerPoint allows you to combine a number of 

simple Shapes to create a complex Shape.  For example, let me demonstrate. 

I’m going to start this demonstration on Shapes by placing Shapes on to otherwise Blank Slides.  

Once we’ve gone through the whole process of Shapes and working with Shapes then what we’ll 

do is we will combine Text and Shapes on the same Slide.  But for now we just want to focus on 

Shapes.  So to Insert a Shape, I make sure that I am in the Insert Tab in the Illustrations Group 

and I select Shapes, and here are a list of the Shapes.  The top are my most recent Shapes.  So 

therefore yours will be different, but the rest will be the same.  You have Lines, Rectangles, 

basic Shapes, Block Arrows, Equation Shapes, Flow Charts, Stars and Banners, Call Outs, and 

lastly you have a special type of Shape called Action Buttons which we can Insert into our 

Presentation and use them as Hyperlinks to other places or other features in our Presentation.  

The whole topic of Hyperlinks, including Action Buttons, is covered in a separate topic in the 

next chapter.  So let’s simply take a Beveled Shape and you’ll notice that we have the little cross 

hairs and we Draw the Size of the Shape.  Don’t worry about getting the Shape right the first 

time because what you can do is you can change the Shape as you go along.  The other thing is, 

is that in most Shapes you have a Perspective Point.  It’s the little yellow triangle.  In this one, 

you’ll notice that I change the Perspective.  The amount that is Beveled increases and the actual 

inner point or inner portion becomes smaller.  Now I can make the whole Shape larger or I can 

make the whole Shape smaller, but it will maintain the same relative Perspective as I have unless 

I go and change it.  Now at a certain point and time I can’t make any more changes.  But you can 

experiment with changing the Perspective on a lot of the Shapes.  If I want to put Text in the 

Shape, I simply make sure that the Shape is selected and say “This is a Shape”.  And basically 

what I can do then is I go Home.  I can go to the Font and I can make it Bold, I can make it 

larger, and I can make it red.  Now the other thing is that I can also use WordArt, and to do that 

you’ll notice that when the Shape is selected I have this Context Tab called Drawing Tools 

Format.  And so what I do is I select that and then I simply go here and I select the WordArt that 

I want to apply to that particular Text.  And, again, I have the capability to change the Fill Style.  
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I have the ability to change the Outline of the Text, and I can make the Text larger.  To do that I 

can go here to the Home Tab Font Group and I can make it larger and I now have the larger Text 

in my Shape.  I just have to be sure that I Grab it.  We’ll go here and we’ll make it stand out.  

And there we have a Bevel Shape with the term “This is a Shape” in the middle.  Now, I’m going 

to Move this one off to the side.  Please note that when I Insert the Text into the Shape when I 

Grab and Move the Shape I’m also Moving the Text.  And it’s kind of large, but we’ll make it 

smaller.  But at some point and time I have to be careful because the Text will become too big 

for the portion of the Shape to contain the Text.  Let’s look at another Shape or type of Shape.  

Now you’ll notice that when I’m in the Drawing Tools Tab Format, I have the Insert Shape 

capability directly in front of me.  And so what I’ll do, in this case, is I will select a Curved Left 

Arrow.  So I go over here and I do or Draw a Curved Left Arrow.  Now, again, I have various 

Perspectives that I can do.  On this one here, I can make the body smaller.  I can make the 

arrowhead bigger.  And if I Grab this one, I will actually be able to change the Perspective again.  

Now in this case, if I type “This is an Arrow”, you notice that the Text in this case goes inside 

the Shape Placeholder.  The square/rectangle around the arrow is where the Text is placed.  I can 

go directly to making this a WordArt.  If I want to change to a different type of WordArt I can 

change to a different type of WordArt.  The other thing that I can do with Shapes is I can change 

and alter them so that they are not Perpendicular or Horizontal, and I can do that.  And basically 

I have an Arrow.  Now, one of the things that’s really good about Shapes is that if you’re going 

to use the same Shape multiple times in a Presentation, what I recommend you do is, is that you 

Create the Shape once.  You then select the Shape, right mouse click, and what you can do is you 

can Copy it.  And then we’ll go down to this one and we will Paste it and we now have an exact 

Duplicate on two Slides of the same Shape.  This is good if we want, as I mentioned, the same 

Shape multiple times throughout our Presentation.  Let’s go and look at some other types of 

Shapes.  Let’s look at the Arrow Shape.  So what I do is I Draw an Arrow and I go over to the 

Drawing Tools Format and when I do that you’ll notice that I have the Shape Styles capability.  

And so what I can do is I can change the Shape Style Weight and Color simply using the ones, 

the options that are shown.  If I want that or I want this one I can do that.  The other thing that I 

can do is I can also use the Shape Outline Commands of the Shape Style.  And in this case, what 

I can do, for example, is change the Weight.  I can also change the Style of the Dashes from a 

Solid Line to a Dashed Line.  And lastly what I can do is I can manipulate the arrowhead.  You’ll 
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notice that, in this case, the arrowhead is pointing to the right.  What I could do is I can actually 

switch it so that it points to the left.  And I can go here in Arrows and I can change so that we 

don’t actually have an arrowhead.  Okay?  The other thing, if I don’t want to switch the Arrow I 

can always simply Grab the Shape, turn it around, and the arrowhead has gone from pointing to 

the right to point to the left.  When I want to connect a Shape, one Shape to another, specifically 

Arrows and Lines to other type of Shapes, what I do is I simply bring them close and what they 

do is they snap in place.  And I can take the same Arrow and I can Copy it and I can Paste it.  

And you’ll notice that when you Paste a Shape it always Pastes almost identical to where it was 

originally.  And basically, I have another Arrow down here.  I can go over here to this Shape 

effect and I can turn this Arrow into red and I can very quickly go and Create various types of 

Arrows in my Presentation.  So, Insert, Shapes.  You can try these out for yourself.  Another one 

that I will show you is a Call Out and, basically, a Call Out is where we want to have a Call Out 

that says something like, “This Arrow is going into this Shape”.  And what we can do is, again, 

anytime we can type Text, I’m not going to use the WordArt, I’m just going to use standard 

Text, and we’ll make it red and we’ll do that.  Now, there is one thing about Call Outs that you 

need to appreciate and I will do it slowly so you will see it, because you may have missed it.  

And that is that when I change the basic Size of the Call Out, I am also Moving the point at 

which the Call Out ends.  So as I make this Shape bigger to handle this Text, you’ll notice that it 

has gone away from pointing where I want, which is no problem because all I do is I simply 

select the Perspective Point on the Call Out and I Move it exactly where I want in the actual 

relative to what it’s calling out.  The other thing that I can do in the Call Out is I can go to Shape 

Fill and I can, for example, have No Fill.  I can change the Outline Color so that the Outline 

Color is the same as the Text.  And I can have Shape Effects and we can have a Shape that’s a 

Reflection.  So we have a virtual total control over the creation of the Shapes in the way in which 

we want them to be.  If you need to have ultimate control over one of your Shapes all you do is 

select the Shape, select the right arrow, and the right mouse, I am sorry, and what you do is you 

go to the Format Shape and this gives you all of the capabilities that you have relative to this 

particular Shape.  Here we have a Solid Fill.  Maybe what we want to do is a Graded Fill.  

Maybe we want a Picture Fill and so we will select Picture and we will go down here and we can 

select a Picture.  Maybe we want a Pattern Fill.  So we can go down here.  We can change the 

Slide Background so that there’s a Background Fill.  In other words, it takes on the Fill of the 
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Background.  So we have all kinds of capabilities in terms of that.  Then we can change the Line 

and we can change the Line Color to red, and we can change the Line Style.  We can make it 

heavier or lighter.  We can add a Shadow, Reflection. We can have Glow or Soft Edges, and we 

have that.  We have 3-D Format and, in this case, you will notice that there is none available.  3-

D Rotation; we can Rotate our Shapes in a 3-D Format if we wish.  So that anything that doesn’t 

apply, then it’s not selectable.  We can do Picture Correction if it’s a Picture.  We can Crop it, 

Size it, Position it.  We can change the Text Box.  We can have the Text going up and down.  We 

have virtual ultimate control over the Shape Appearance and the Text in the Shape we’re 

working with.  And this applies to all of the Shapes.  Now, obviously all of the capabilities are 

not going to be the same.  If we, for example, select the Line and we go Format Shape, there are 

certain things that we don’t have the capability to do.  We can do a Shadow if we want; we can 

put a Shadow on it; and we can have a Reflection and we can have a Reflection of the Arrow.  So 

we can have some capabilities, but not as much as we can have when we have actual Text in it.  

What I’m going to do now is to go to this Shape.  I’m going to Move this Shape into the middle 

and what I’m going to is I’m going to Insert another Shape and this time what we’ll do is we will 

put a Rectangle around our Bevel and we will go there.  And this case, what we will do is we’ll 

go to Format, and what we’ll do is we’ll go Shape Fill, No Fill, and we’ll go Shape Outline and 

we’ll make it red.  And what we will do is we’ll change the Weight so you can see the Weight.  

And basically what we’ll do is we’ll Expand this Shape so that it is not obscuring the Text that 

we have entered.  And basically what we have is we now have a Triangle on top of our Beveled 

Shape.  Now, one of the things that we can do is we can build up Complex Shapes by taking 

simple Shapes and putting them together.  So, for example, if we wanted to put this Arrow with 

this Shape we now have three Shapes, but what we can do is we can Group those three Shapes so 

that they act like one Shape.  And all we have to do is, first of all, select the first Shape, hold 

down the Control key, select the next Shape, select the third Shape, and then go to Format and 

you’ll notice in Format we have Group and we say Group, Group.  And therefore you’ll notice 

that our Shape now has one Placeholder and when we select the Placeholder and we Move it, 

everything gets bigger relative to its original dimensions.  The other thing that is a powerful 

capability of combining multiple Groups is that we can Cut and Paste this very simple.  So I’m 

just going to quickly Insert another Title only Slide.  I go here.  I’m going to go to the Copy.  I’m 

going to go down here and I’m going to go Paste, and therefore we have the same Complex 
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Shape that is Pasted on to this Slide as from this Slide.  Now let’s talk about Shapes and Text.  

So to do that what I’m going to do is to put in a New Slide and, in this case, I’m going to have a 

Slide with Text.  So I’m going to say, “This is a Slide with a Shape”.  Now, I could go and say, 

This Slide shows how to have Shapes and Text on the same Slide.  And basically then I take and 

I’m going to take my combined Shape and I’m going to Copy it.  I’m going to bring it up there 

and I’m going to Paste it.  Now, you’ll notice that it Pastes in the same position on the New Slide 

as it was on the old Slide and basically what I can do is I can Move the Shape to the side.  But 

you’ll notice that, if I leave the Shape this big I have a problem because the Shape and the Text 

are overlapping.  But that is very simply solved.  And that is I simply select the Text and I use 

the Placeholders associated with the Text and I Re-format the box that is available for the Text 

so that now I have the Text beside the Shape.  And basically I could go here and say, “This is a 

second point”, and I could keep doing that.  Okay?  So what I could do is I can organize the way 

in which the Shape and the Text operate on the same Slide.  I could go down here and I could 

Insert another Shape and we’ll just quickly put in a Smiley Shape and we’ll go to Format and 

we’ll go to Shape Style.  And we’ll have a Shape and we can make it happy or sad, changing the 

Perspective.  But this is a happy smile, so we can do that.  So we can have multiple Shapes 

around the Text.  Now, what happens if I have or want some Text towards the bottom right of 

this particular Slide?  Well one of the things that PowerPoint presents us with or provides us is a 

Text Box.  So therefore, what we can do is we can select a Text Box.  We can go down here and 

we can say, “This Text was entered in a Text Box”.  Now, we have full capability to Format the 

Text in a Text Box just the way we did the Text in the original Slide.  I’m going to simply show 

you that we can go here and we can make it larger, and we can change the Size of the Text Box, 

and we can do that.  We can Center the Text and we could actually, if we wanted, we could 

actually Fill the Box and make it red.  A little bright, so maybe we’ll make it a little less than 

that, and basically we now have an extra Text Box in the Slide.  So this is Text, this is Text, this 

is a Shape, and this is a Shape.  Fairly powerful capability to combine Text and Shapes on the 

same Slide.  One of the things that we can do also is we can organize the way in which Objects 

are displayed.  So what I’ve done is I have Moved the Smiley Face on top of the Text, but what 

would, what I really wanted to do is to have the Smiley Face as a Background to the Text.  To do 

that all I do is put the Smiley Face on top of the Text and then I select one of the two, one of the 

two, either the Text or the Shape and I right mouse click and you’ll notice that I can bring it to 
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the back or backward.  Now, bringing it back or backward is the same unless there are more than 

two Shapes.  In my case, I’m going to send it to the back and you’ll notice that I now have the 

Smiley Face behind the Text.  So anytime you have multiple Objects occupying the same space 

you can select the Object, you can select the Object and right mouse click and basically what you 

can do is you can bring it the front or bring it forward, send it to the back or send it backward.  

So we can actually pile Shapes on top of one another so that they are organized in exactly the 

way we want them on the Slide.  Now the Shapes that I have been working with are in 

PowerPoint, the people who use PowerPoint all of the time are considered to be very simplistic.  

I want to show you that with a little work and effort it is possible to Create some very, very 

powerful Shapes in PowerPoint.  And to do this what I have done is I have Downloaded, and I 

will give you the place to go to Download this, I have Downloaded a PowerPoint Presentation 

that Microsoft developed to show you how to Create 3-D Shapes and Objects for PowerPoint 

Slides.  So just let me very quickly, I’m not going to show you all of these, but just to show you 

what I’m talking about in terms of some of the Shapes and Effects that you can Create in 

PowerPoint.  Now, in this particular Downloadable File from Microsoft, the instructions for how 

to Create the actual Effect is in the Notes portion of the Slide.  In a subsequent topic in the next 

chapter, we’re going to go into the whole issue of Notes, but basically in this particular File they 

have provided you with the details, step-by-step instructions, on how to Create any one of these 

3-D Effects.  Now the other thing that you can do is you can also do this.  Let’s go down to the 

Ring and what we’ll do is we’ll go Copy.  We’ll go back to our Effective Presentations and what 

we’ll do is we will simply Paste the Slide and here is the three Rings Copied into out 

Presentation from the other Presentation.  So, again, a very effective way of creating very 

complex, but very pleasing Shapes in a PowerPoint Presentation.  As shown in the 

demonstration, Microsoft provides a PowerPoint deck which some very powerful 3-D Shapes.  

To Download the PowerPoint File to your computer go to Microsoft.com, Search PowerPoint 3-

D Shapes, select the first result on the Search Results, and you will see the screen as shown 

below.  Simply select Download and Download the File to your computer.  Don’t worry that it 

says PowerPoint 2007, it works perfectly in 2010.  And at the bottom of the screen is the actual 

URL of the Download. 
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Video:  Working with Tables 

 
James:  In this topic, we will talk about Working with Tables.  This is a Table on Tables.  We’re 

going to talk about how we can create a Slide that is a Table, like this Slide.  We’re going to talk 

about adding a Table to an existing Slide.  We’ll talk about enhancing Tables.  We’ll talk about 

the complexity of Tables.  For example, you can have a Row that consists of two Columns or 

you can have a Row that consists of seven Columns, six of which are one size and the seventh is 

a different size.  Let me demonstrate. 

When you are creating a Table in PowerPoint the first question that you need to ask is, Is the 

Table going to be the Slide or is the Table going to be part of a Slide?  Both are possible in 

PowerPoint and it just makes your life easier if you make that decision before you get too far 

down the road.  I’m going to show you both, but I’m going to start with the situation where the 

Table is the Slide.  So I’m going to Insert a New Slide.  And I’m now going to Insert the Table.  

Now, the second question that you need to ask yourself is: How big is this Table?  You don’t 

have to be absolutely precise because I will show you that you can Add Rows and Columns after 

the fact.  But it helps if you have a Table to start with that approximates the size of the final 

Table.  In our case, we want to have the Sales by Region and we have 11 locations and we have 

therefore a Title and we have 11 locations, so we need 12 Rows.  So, we have 12 Rows.  Now, in 

terms of Columns what we want to do is we have two Regions, we have Cities within the Region 

and we have Districts within the Cities.  So therefore we have Regions is one, Cities is two, 

Districts is three, and the actual Sales is four.  So what we need is a Table that is four Columns 

by 12 Rows, and we say OK.  Now, the next question that you need to ask yourself is: When the 

Table is the Slide, are you going to have a Slide Title or are you going to have a Table Title and 

no Slide Title?  I want to show you that you can Create Tables without having Slide Titles.  So 

what I’m going to do is select the Slide Title and I’m going to Delete it.  Then what I’m going to 

do is I’m simply going to Move the Table so that it’s closer to the top of the Slide.  Now, I could 

say, “Sales by Region”, but obviously Sales by Region applies across all of the Columns.  So 

what I want to do is to show you that we can actually, first of all, Merge these Cells.  So I select 

the four cells.  I’m going to show the right or secondary mouse Menu and I’m going to say that 

what I want to do is to Merge those Cells.  And just to show you that it worked, what I’m going 

to do is I’m going to Center the Text.  So therefore I now have Sales by Region Centered, and so 
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then I can start to enter the Data and I have the Northeast Region.  I can move from Cell to Cell 

by simply pressing the Tab key or using the mouse.  And the first City in the Northeast is 

Boston.  The first District is Boston and Boston Sales are 25 million, and the second District is 

Cambridge and its Sales are 12 million.  And I can go back here and I can correct the Spelling of 

Cambridge and there.  Now what I’m going to do is Pause the recording while type the rest of the 

Data into the Cells, then we’ll come back.  We’ll have a Table with Data and we’ll continue to 

work on it. 

All right.  Here is our Table with the basic Data.  And you’ll notice that in Chicago, we only 

have one District so I have elected to repeat the word Chicago so that there is something in this 

Cell.  Whether you choose to do that or not is entirely up to you.  So basically we have this.  

Having looked at it I have decided that what I need to do is if I’m going to only show the Sales 

or not $25, they’re $25 million, I need to be sure that my Table indicates that.  So what I need to 

do is I need to Add a Row.  Now, if I selected the Sales by Region Row, I could Insert a Row 

above or below and it would be identical to this Row because that’s what happens when you 

Insert a Row.  When you Insert a Row, what happens is the Row that you’re in is Duplicated.  

And so what I’m going to do is I’m going to select the Cell that has Boston.  I’m going to bring 

up the secondary Menu and I’m going to say Insert and, in this case, I want the Row above 

where the cursor is, so I Insert Row Above and you’ll notice that I now have four Cells.  So what 

I can do is I can Label this Region.  I can go over there and I want to have one Title that covers 

these three Columns.  So we already know that we can Merge.  So I will simply Merge those 

Cells and what I will do is enter Sales in dollar sign, millions and I will Center it over those three 

Columns.  Now, the other thing that we can do is say we wanted the term Northeast to clearly 

apply to Boston, Washington, and Chicago.  What I could do is I can Merge Cells going down.  

So I select all of the Cells in that Column and what I do is I say that I want to Merge.  And 

basically what I can then do is using the Paragraph the Home Tab, so the Paragraph of the Home 

Tab, I can go and I can indicate where I want the Text to be placed in the Cell.  So I can say I 

want it to be placed in the middle.  Now, again I’m going to Pause the recording and I’m going 

to combine a bunch more Cells and then I’ll come back and I’ll show you how we can Format 

the rest. 
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Alright, what I have done is I have Merged so that we have one Cell with Northeast, one Cell 

with Southwest, and I have Centered the Text.  We have one Cell for Boston, one Cell for 

Washington, one for Phoenix, and one for Dallas.  And I chose to leave the Text Aligned at the 

top.  However you want to do it you can do it.  I can then go over and select all of the Dollar 

Cells and I can say that I want to Center them.  The other thing is, is that it is possible to make 

Global changes in things like Text, Size, and Style by simply selecting the Table.  Okay?  And so 

what I’m going to do is select the Table and I go there and I’m going to make this Bold.  I’m 

going to make it 20.  And I can go here and we can now start to make this look like a really 

professional Table.  The first thing I can do is you’ll notice that when I go to Design what I can 

do is I can select a WordArt Style.  So I can make this WordArt.  And I can make it larger than 

the rest, more like a Title.  And so what I can do is I can actually go through and make those 

changes.  Now that probably isn’t going to stand out sufficiently.  So what I can do is go back to 

my WordArt Style and I can select a red Fill and I have that information.  Now, how about the 

fact that some people look at that and go: Well, I’m not sure that that’s exactly the Style that I 

want.  So basically you’ll notice that when I select a Table I have two Context Tabs for Table.  

One of which is the Design and one of in the Design I have Table Styles.  So what I can do is I 

can actually Open up this and I can see if there is a better Table Style.  Maybe I want to make it 

Lighter.  Maybe I want to make it Darker.  Maybe I want to Change the Color entirely.  So what 

you can do is you can select what you want.  Now I’m going to pull this Menu a little off to the 

side and basically then you will notice that when I make the changes you can actually see them.  

Okay?  So as I hover, if you look at the Table in the background you’ll notice that it changes.  So 

when you get to the one that you think is the one you want, what you can do is you can go and 

say, let’s see and okay.  So there we have it.  Now this clearly shows which has been combined 

and which hasn’t combined.  So we can now start to work on that.  One of the things that I can 

do is I can actually Add Borders or Change the Borders around the Cells, and to do that you’ll 

notice that in the Design Tab I have the Draw Borders Group and what I can do is I can decide 

what Weight of line I want.  And I can decide what Color I want and we will pick a very dark 

blue.  And I can actually decide whether I want Solid Line, Dotted Line, or what.  I will pick a 

Solid Line.  And what I can do is I can go over and I can change the Lines that I want.  So I can 

actually Design and define the Lines that I want to stand out in my Table, and others I don’t have 

to.  So you can go through and you can fill out the exact Lines by Drawing Borders around the 
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Cells that you want.  You can also, oh to leave that all you have to do is press Escape and you’re 

back to a Normal cursor.  What you can do is you can also decide that you want to change the 

Fill of the particular Cell or Cells.  So what you can do is you can go up to the Table Styles.  You 

can Open up Shading and, again, you will notice that as you select a different Shading it actually 

shows you what the Shading is.  And so what we can do is we’ll select that Shading for Chicago.  

And we could have a different Shading for Los Angeles.  And we could go over there and we 

could do that; a little difficult to read so let’s make it slightly less intense.  Now, again, I’m 

showing you that you have the capability of going in and working Cell by Cell or selecting a 

Group of Cells and working with those Cells.  To continue the Formatting of the Table, I’m 

going to switch to another version that doesn’t have all of these partial Formatting capabilities 

because sometimes when you do little bits of Formatting for specific Cells, you end up with 

some problems.  So basically what I’m going to do is this is another version of the Table that is 

like the one before and what I’m going to do is I’m going to select the Table and I’m going to go 

to Design and I’m going to go to the Table Styles Group, but I’m going to Open up the Effects 

List and I’m going to select the Beveled.  And basically when I select the Bevel you will notice 

that the Table as a whole, all of the Cells are going to be Formatted in the same way.  So I can 

decide which one I like best and I can keep going around and I can decide which one I think is 

the most effective for the particular Table that I’m working on.  I think that we’re going to have 

Convex.  So we go to Convex.  Now, just let me explain that the other part of this is that I can 

Add a Shadow, and I can Add an Outer Shadow. And we’ll select an Outer Shadow Offset Left, 

and we have a slight Shadow on our Table over on the left.  It’s not that apparent, but it is there.  

Shadows are not particularly relevant for most Tables, in my experience.  So, basically we have 

this Table.  Now, we can go to the Table and we will look very briefly at some of the Layout 

Options.  Basically what we can do is we can actually change the specific Cell Size, okay, by 

selecting a Cell.  And if we want to make this one higher, bigger Row, we can actually Increase 

the Row Size.  Okay?  So we can actually go in and change individual Cell Sizes.  We have the 

Text Alignment or Direction.  We probably don’t want the Region to be that, but we could do 

this.  We could go down to where it says the Northeast and we could go for Northeast and we 

could go down and say, Southwest.  All right?  So you can go through and change the Text 

Direction.  And you can Insert below, left, or right, above or below, or you can use the secondary 

Menu.  I tend to use the secondary Menu, but basically you can use the Insert as above.  In fact 
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what we’ll do is we will do that and what we want to do is we want to Insert a Column on the 

right because what we want to do is to enter the amount by which the Current Sales are over or 

under budget.  So what we can do is we can say Insert Columns to the right.  And basically 

you’ll notice that we have a Column.  Now what we have to do with this Column that we’ve 

added at the top, we have to Merge the Cells so that the Sales by Region encompasses the whole 

Table.  We go to this and we say, Over/Under Budget.  And you’ll notice that when the Cell 

becomes full and we continue to type, the Row Expands to accommodate the Text.  And we 

could go down here and we could put in, we can either do it by dollars or percentages.  We’ll do 

it by percentages.  So we’ll say 12%.  And Cambridge is not doing well, so we say 5%, but what 

we want to do is to say 5% Under Budget.  So what we can do is we can change that to red. And 

then what we can do is just so that everybody will understand what we’re doing, we can select 

the word Under.  We can select the word Under and sometimes selecting words are a little bit of 

a problem, but we will select Under and we will go down here and we will Delete the black R 

and we will put in a red R.  And therefore we now have black meaning Over, red meaning 

Under.  So we could go in and fill out the rest of the Cells in this Table.  What I want to do now 

is to switch to a Table that is part of a Slide.  So I’m going to Pause and bring that Slide up and 

then we’ll talk about incorporating Text and Table on the same Slide. 

Okay.  I started this Slide.  I created the Table.  This Slide wants to talk about the Sales by 

Product.  So therefore we have the Product A, B, and C and the Sales for 2010 year to date and 

we have the Table.  But what we want to do is we want to put some Comments on this Slide in 

the Form of Text about the Sales by Product.  And you’ll notice that there is currently no place to 

do that.  But one of the things that you can do is you can always change the Layout of a Cell.  So 

what we’re going to do is we’re going to select a Title and Content and we have the Text 

capability in the Content and we can go and select it and say Product A is 25% above Budget.  

But you’ll notice that by Default the Text area that we get is from the left of the Slide to the right 

of the Slide, but we don’t have to live with that.  Basically what we could do is we can actually 

change the Size of the area devoted to Text.  In this case, we’re simply going to Grab the right 

edge of the Text Placeholder and Move it to the left and we’ll say “Product A is 25, Product B is 

7.5%, and Product C has only been in general, this star I-B-U-T-I, for three months”.  Now, 

again what we can do is we can enhance the Text.  So, for example, to make the Product C stand 

out what we could do is we could go and choose a different type of Bullet for that particular, that 
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particular point so that the fact that it’s different than the rest will stand out, alright?  And 

basically we can create Text around the Table.  Now the other thing that we can do is we can 

always Add the Table to a Slide that has Text.  I started with the Table and Added Text.  That is 

not the only way.  You can have the Text and Add the Table.  Tables are a very powerful way of 

focusing people’s attention on your Data and you want to consider using them in your 

Presentations. 
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Video:  Using SmartArt 

 
James:  In this topic, we’re going to introduce you to using SmartArt.  This is a SmartArt 

PowerPoint Graphic.  SmartArt consists of Graphical Lists, Processes, Cycles, Hierarchies, 

Relationships, Matrices, Pyramids, or Pictures.  I must warn you that you must select the proper 

Category, which means you must be very clear on what you’re trying to communicate.  You need 

to know what structure can best display your Data.  How much Data there is to display has a big 

impact on SmartArt.  Some of the Graphical Shapes do not hold a lot of Text.  Let me 

demonstrate. 

In terms of SmartArt, it helps enormously if you have some idea as to what Text you want or 

what information you want to place in the SmartArt Shape.  As I will show you later, while it is 

possible under certain circumstances to create a SmartArt Shape and Convert it to another 

SmartArt Shape. In some cases when you Convert, the results are very strange and in general 

may not be acceptable.  So what we’re going to do is we have decided that we want to take this 

information, now you don’t have to Create a Slide the way I had, I just wanted you to appreciate 

it.  We want to Create a SmartArt Shape that uses the four points of Modus Perspective level of 

knowledge and work style.  We’re going to Expand those into a little more elaborate statements 

and then we’re going to show that we can have on the same Slide a Text Box that talks about the 

bottom line.  So what we’re going to do is we’re going to Insert a New Slide.  We’re going to 

select from the Options the Insert SmartArt Graphic.  Now, we know that we want a list so we’ll 

come back, but let me very quickly walk you through the other SmartArt Shapes.  We have 

Process Shapes.  When you see a Process Shape that you want more information of, you simply 

select it and you get a Picture on the right with a description.  So this is a continuous block 

process used to show a progression or sequential steps at a Task Process or Work Flow.  In terms 

of Cycles, we can have a Segment Cycle.  We can have a Diverging Ring Cycle.  We can have a 

basic Radial Cycle. We can have a Cycle Matrix. We have various Hierarchical Shapes. We have 

a Horizontal Hierarchy. We have Relationships. And this is a Table Hierarchy.  We have a 

Matrix.  This is a Titled Matrix.  We have Pyramids.  And we have Pictures.  I will show you an 

example of what you can do in terms of SmartArt and Pictures at the end of this demonstration.  

In our case, we know it’s a List.  Okay, so we’ve now narrowed it down to List.  All we have to 

do is decide which of the List Options we want.  And so we could look at Picture strips, well it’s 
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really not Pictures.  Anyhow, to save time let’s go and use the Vertical Chevron List because 

I’ve used this before.  It’s very effective and basically what it does is it lends itself to having 

blocks of Text in a SmartArt Shape.  So we will click OK and you will notice that we can Add a 

Title, and the Title is Know Your Audience.  And then what we can do is we can now go and 

complete the SmartArt Shape.  When the SmartArt Shape is selected you will notice that you 

have two Context Tabs.  There’s the Design Tab and there’s the Format Tab.  We’re going to 

start with the Design Tab.  Now we could actually, in this particular case, we could type the Text 

directly into the SmartArt Shape.  Some SmartArt Shapes, typing Text is not that simple.  So 

therefore, for SmartArt Shapes there is what is called a Text Pane.  And basically I’m going to 

turn on the Text Pane so that you will understand it and you will be able to use it, especially in 

those instances where it really saves you a lot of trouble.  So we select the Text Pane and we go 

up here and this is our first point and then our first point is, “What are their motives for 

attending?”  Now, I’m going to Pause the Display and what I’m going to do is enter the rest of 

the Text for the next three.  I won’t enter the fourth.  I will show you how to do that when I come 

back. 

Alright, I have entered the first three of our points about Know Your Audience and now we need 

to add a fourth.  Now you’ll notice that what we can do is we can Add a Bullet or we can either 

Promote or Demote.  Now, in this case, if we Promote the second Bullet under three it’s going to 

become number four.  So what we do is we type a fourth and then what we do is press Enter, 

which would give us a fifth.  We don’t want a fifth so we Demote the fifth to become the Text 

portion underneath number four and that is, “What is their work style?”, and so basically we 

have entered that.  Now what we got to do is we have to go and Remove the extra Text.  So what 

we do is we select it and we Delete it, and then we simply go Promote that to three.  And it takes 

a little Moving around, we Demote that and we have it to three and we would do the same for 

number one.  Or we can Close the Text Pane and in this case we can simply go over here and we 

can Delete the Text because we can see it.  So basically we now have our basic SmartArt Object 

Created.  What we can do now is we can start to make this easier to read, more attractive, more 

appealing.  One of the things we can do is we can actually change the Color.  So if we don’t want 

the blue Color, what we can do is we can say a Colorful Range.  We have another Colorful 

Range or we have another Colorful Range.  Basically we can select, ah let’s go with a Colorful 

Range.  Okay?  So basically we’ve got a Colorful Range.  The other thing you will notice is, is 
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that we can actually change the way in which the Chevrons are displayed.  So we could go and 

we could have a Cartoon Chevron and you’ll notice that we also have the capability to, in this 

case, move from right to left. And so we could actually have the numbers there.  We look at it 

and go, Nah I don’t think it’s good, so we’ll move it back.  Now, exactly what you’re going to 

see in terms of Layout and SmartArt Styles depends on the SmartArt Object that you’re working 

with.  But the point is, is that we’re not changing the overall Shape.  We’re not changing the 

basic Layout.  We’re simply changing within that Layout and therefore we have no problem of 

going and going, well let’s go and do that Color. So we can change the that.  Now in terms of 

Formatting, I bet you are not surprised to note that what you can do is you can Create Word 

Styles and WordArt Styles, and basically you can change the Text Fill.  And you can go down 

here and you can Create a different one.  And I’m not going to take a lot of time because we’ve 

covered this is a number of topics.  But basically if you simply want to have some of them that 

are simply standard, you can do that.  The other thing you can do is you can go and Increase the 

Size, and basically we’ll Increase that Size and make them a little easier to read.  And that one’s 

a little too big, so we’ll make it the same as the other.  And basically, we now have our basic 

Word, sorry, our basic SmartArt Shape completed.  Now the other thing that we can do in the 

SmartArt Tools Format Tab in the Shape Styles Group is we can go over here and we can go, 

Okay we want this one to be that, and then we can go down to this one and we want it to look 

like that, and then we can go down and we can select this one, and we can go down to the bottom 

one and we can select.  So what we can do is we can select the Shape Styles.  We also have the 

capability of applying Shape Effects.  So, for example, we can put a Shadow, an Outer Shadow.  

We can go down here and we can have it Glow.  We can go down here and we can have it 

Beveled.  Some of these are work slightly better than others.  That one doesn’t seem to be doing 

very much.  This is a matter of practice.  And basically Beveling doesn’t look like it’s working 

on that one, so we’ll go back and we’ll forget about Beveling and we’ll go to a Reflection, and 

we’ll have a Reflection.  And on the bottom one we will have another Soft Edge of 2.5 points.  

Okay?  So basically what you can do is you can go and you can select the SmartArt Shape and 

then you can change the Shape.  Now if I had selected all of them at once, then basically what I 

would have done is I would have Formatted them all at once.  But I wanted to show you that 

basically what you can do is you can go in and shape them exactly the way you want.  Now what 

I’m going to is I’m going to Duplicate this Slide in case something happens in the next step that 
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it all falls apart.  This is one of the nice features of Duplication, because Duplication takes the 

Slide and immediately following creates a Copy of it.  And therefore if everything falls apart and 

I want to, I can simply blow away the results and I still have the Shape, the SmartArt Shape on a 

Slide that I’m happy with.  So what I’m going to do is I’m going to select the SmartArt Shape.  

I’m going to go and I’m going to say: Now what happens if I wanted to change that?  Well, what 

happens if I wanted to change it to.  You’ll notice that the first thing is, is that this one is made 

for Pictures.  So the little Bullets, the little circles at the beginning are for Bullets and therefore 

the one becomes a point, the two becomes, and well that’s, that’s not very good.  In this case, I 

can Undo it.  I can then go back to what it was and so we can go and what happens if we do this?  

Well basically, this is even worse.  This people is the point that I was trying to make, is that it is 

not always possible for you to actually go and simply flip from one Shape, from one SmartArt 

Shape to the other.  So what you want to do is you want to think through what you’re trying to 

accomplish and spend a few extra moments at the beginning to get the right Shape and then what 

you can do is you can go forward.  Now we could go and we could see if one of these others is 

going to work any better.  But you’ll notice that we’re not getting better.  In fact, I think most 

people would think that this is not nearly as good as the beginning.  So therefore we have 

decided, we could try more, but I won’t waste your time.  You can experiment with this, but 

basically what we’re going to do is we’re simply going to go and Delete this Slide and therefore 

our Duplicate Slide is now the one that we’re going to work with.  Now, if we go back to the 

original you’ll notice that we have not dealt with the bottom line, You must ultimately create a 

Picture of the individual to whom you are going to communicate.  Now, what we could do is we 

could try and squeeze it into the bottom of this Slide, but the other thing I want to show you is a 

tip when you are working with SmartArt.  So what we’re going to do is we’re going to again 

Duplicate the Slide and, in this case, what we’re going to do is we’re going to make the SmartArt 

much smaller.  Okay?  So what we’re going to do is to select the Smart Art and we’re going to 

go and change all of the Text so that it is, well maybe 16 is a little small, so we may want to 

make it 18.  But basically what we’re going to do is we’re going to have our SmartArt Shape 

there and what we’re going to do is we’re going to put the bottom line as a separate piece of 

Text.  Now the other thing I want to show you is, is that it is very easy to Create a Text Box and 

Move it from one Slide to the other.  So what I’m going to do is I’m going to Insert a New Slide 

and here is a Slide Box that’s got our standard Bullet.  We’re going to go up here and instead of 
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typing I’m going to Copy, and we will go down here and we will go and we will Paste.  And so 

we have is we now have a Bulleted item that is identical all of the other Bulleted items in our 

Presentation.  We’re going to make the Box a little smaller.  What we’re going to do is we’re 

going to select the Box and just to show you what we’re going to do is we’re going to Cut the 

Box.  We’re going to go down to this Slide here and what we’re going to do is we’re going to 

Paste the Box and you’ll notice that it Pastes in the same position, but that’s no problem.  All 

we’re going to do is Drag the Box down to the bottom and now we have a second Slide and what 

I’m going to do is select the Slide that was in the middle, where I created the Text, the Bulleted 

Text.  I’m going to Delete it and now we have the first Slide which says, Know Your Audience 

and we have the Bulleted points, and then we have the second Slide which has the Bulleted 

points less intense, less pronounced, smaller, and the bottom line.  Now in the next chapter there 

is a topic on Animation.  This would be a perfect Slide for Animation because what we would do 

is we could Animate the Slide so that when we move from this Slide to the this Slide, the 

SmartArt appeared as soon as the Slide comes up and then we get to control when the bottom 

line comes in using Animation.  So if you’re following along remember when you Create this 

type of Slide, Animation is a very effective.  Now one other thing I want to mention to you and 

this again is entirely up to you, a lot of people who Create PowerPoint Presentations have a rule 

that says, if you have multiple Slides with the same Title you need to let people know that there 

is multiple Titles or multiple Slides dealing with exactly the same topic.  Some people put in the 

word Continued.  I am one of those.  I’m not saying that I’m right, I’m just saying that this is 

how I do it.  What I do is I put in the one and two.  Now just to show you how this is going to 

look, because remember ultimately we want to see this in Slide Show Mode.  So what we’ll do is 

we’ll go Slide Show.  And here is our first and we talk about our four points, Knowing Our 

Audience.  We go to the next Slide and we say the bottom line is you must Create a Picture of 

the individual to whom you are going to communicate.  So SmartArt combined with Text.   

I want to conclude this demonstration by showing you what is possible with SmartArt.  So what 

I’m going to is to switch to an Animated Hierarchy and Process Graphics with SmartArt to show 

you some of the possibilities that you can achieve with SmartArt.  And basically you will notice 

that we have the Title with Pictures.  We have Text Label 1, 2, and 3.  A little more sophisticated 

than our three.  Topic 1 Supporting Text.  Topic 2, Topic 3, and so on.  Now I’m not going to go 

through.  Here’s another example of the one that we were doing.  And basically you’ll notice that 
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I mentioned Animation.  Animation really helps when it comes to SmartArt.  And this actually 

has four, so we could’ve actually used this in our Presentation.  So basically, you have access to 

this and I will give you the website to go to where you can Download this Animated SmartArt 

Presentation.   

I mentioned in the demonstration Microsoft has Animated SmartArt.  To find this SmartArt you 

go to Microsoft.com. You Search for Free Animated SmartArt.  You’ve got include the word 

Free.  If not there is going to be a whole lot of options.  The first result state Free Animated 

Organizational Charts with SmartArt Graphics.  But it is actually much more.  It is the examples 

that I showed briefly during the demonstration.  What you do is select Download and you know 

you’ve got to the right place when it says Free Animated Organizational Charts with Microsoft 

Graphics for PowerPoint 2007.  Again, don’t worry about the fact that it says 2007, it works 

perfectly with PowerPoint 2010.  And if you have any problem, at the bottom is the actual URL 

of the Download site. 
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Video:  Using Templates 

 
James:  In this topic, we’re going to talk about using Templates.  A Template is simply a 

Presentation Design.  It contains all of the elements of a Presentation, a Slide Master or Masters 

and their associated Layout Masters.  You can use predefined Templates.  PowerPoint 2010 

gives you predefined Templates.  You can Create your own Templates.  You can Search 

Office.com for Templates.  You can actually Search the web for Templates.  Let me 

demonstrate. 

Mentioned in the Introduction a Template is a Presentation Design.  Now normally and certainly 

as you gain more experience what you will do is you will first of all determine what Template 

you want to use and then you will Create your Presentation.  For purposes of the training what I 

wanted to do was to concentrate on the individual building blocks of a Presentation without the 

potential confusion that a Template would give.  So what we’re going to do is we’re first of all 

going to show you how to start a New Presentation and choose a Template to associate it with it.  

And then we’re going to show you how if you get a Presentation, such as this, that doesn’t have a 

Template or has a Template that you don’t like, how you can actually Assign a Template to an 

existing Presentation.   

So basically if we go back to the beginning we would go File, New and you’ll notice that we 

have all kinds of Recent Templates, Sample Templates, My Templates.  We have Agenda 

Templates.  We have Awards, Certificates.  We have numerous Template Styles that come with 

PowerPoint 2010.  So what we can do is we can just go to Flyers, for example.  We have Event 

Flyers and you’ll notice what it’s doing is it is Searching Office.com looking for various Fliers.  

And when we get the one we want we could select it.  So what we can do is we can go through 

and look at the ones that are My Templates and here is the My Templates, and basically what 

you can do is select the one you want.  And you can go to Jigsaw and you now have a New 

Presentation based on the Jigsaw Template.  Now, in the beginning of this chapter we talked 

about Slide Appearance.  There is nothing stopping you from Opening up a Template and 

making changes.  No, there’s no restriction; there’s no requirement that you actually accept every 

component of a PowerPoint Template.  So to do that what we do is go View and we go to Slide 

Master and here is our Master Layout, and here is our Layouts.  And so what we can do is we 
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can go here and we can go Yes, but what we want is, we want to change that.  We don’t like 

Times Roman.  What we want is Bell MT.  We also want to Move it slightly higher.  So what we 

can do is we can change the actual Content of the Template before we make any changes.  And 

you remember one of the things that is the power of the Slide Master and its associated Layout 

Masters is that even if you have entered Text you can go back and change the Master Layout or 

the Layout Masters and the changes will be applied to all of the existing Text.  So, for example, 

we could go down there and we could change that.  So we can do any changes we want in the 

Template.  We don’t have to live with the Template the way it was given to us.  And basically 

what we do is we simply Close the Master View and now what we would do and this is again is a 

recommendation from myself to you based on experience, what I do is I always before I go too 

far, I go “This is a Slide” and basically I go “This is a point” and “This is a sub-point”.  All I’m 

pointing out is, is that what I do is I simply test out a couple of Slides to see if I like them.  But 

the place to test them is not in the creation portion, it is in the actual.  I’m just putting in a Title 

here.  Is a, the Slide Show View.  And so basically you can see is this the effect that you want to 

have surrounding your Content?  Do you want these three Colors?  Yes?  No?  I leave that up to 

you.  But basically what I’m saying is, is before you Create 8, 10, 12, 200 Slides, what you want 

to do is test out your Template to see if it is what you want.  If it’s not what you can do is now 

that you’ve got a couple of Slides created you can actually go View, Slide Master, and maybe 

it’s as simple as going here and changing the Bullet so that it is the same Color as the Text.  And 

going here and changing the second level, the second level to be the same Color.  And, again, 

have it as the same Color Bullet.  It could be as simple as that.  We’ll also change the Text and 

we can go to the Slide Master.  We can Close the Slide Master and go back up here to the first 

Slide and very quickly go and say: This is, in my opinion, it’s my opinion, this is certainly a 

better use of this Template than the first one.  But again I leave it to you to decide.  But make 

your decision in the Slide Show View.  Don’t look at it here, look at it in Slide Show.  Now what 

I want to show you is how to Add a Template after the fact.  This is the recommended process.  

You Start the Presentation.  You select the Template.  You change the Template as required and 

then you build the Presentation.  But there are instances where you may not like the Template or 

you want to change the Template or, as in my case, you build a Presentation without a Template 

and you want to after the fact add a Template to a Presentation.  So what I’m going to do is I’m 

going to switch to our Effective Presentations, this is the little sample that we have been using as 
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we have gone forward.  And what I’m going to do is I’m going to Create a New Presentation and 

I’m going to use a Template that I already have and it’s called the Effective Presentations 

Template.  And so therefore I now have a Template on that I want to use, but what I am missing 

is I’m missing the fact that I want to Add a Graphic to the Template.  Now we’re going to, in the 

next chapter, talk extensively about Graphics, but I want you to appreciate at this point and time 

in the training that it is possible to Add Graphic Images to your Template so that when you’re 

building your Slides, you will not use the area associated with the Graphic.  If you’re going to 

put a Graphic on a Template then be sure you do it at the beginning of the creation of the 

Presentation so that you don’t run into the situation where you’re Text or Shapes or Tables or 

SmartArt or Word, whatever, that you’re using overruns, overlays the Graphic.  To do that I’m 

going to go to the View and I’m going to go to the Slide Master View and I’m going to go here, 

and here is the overall Template.  And what I’m going to do is I’m going to go to Home, sorry 

I’m going to go to Insert, my fault.  I’m going to go to the Insert Tab.  Now, again, we’re going 

to talk about this in a subsequent topic in detail, but for now all I want to do is Insert a Picture 

from a File and basically I’m going to Insert a Picture of, that says, Microsoft Office 2010.  And 

basically I have already sort of preset this Presentation up for that, and that is I’m going to add it 

on the bottom right hand corner of the Presentation.  Now you’ll notice that because I added it on 

the Slide Master, it was automatically added to each one of the Layout Masters.  If for some 

reason I didn’t want it on a particular Layout Master, for example, if I don’t want it here because 

you’ll notice that my Title is coming very close to the Graphic.  What I can do is I can go and 

alter it in there.  Or I could go and simply Move this up so that it would be there.  And basically 

what I could do I can go through and look at the various Slides I have and what I can do is decide 

if I need to do any reorganization.  When I get done I simply Close my Master View and my 

Graphic is now there.  Now, I now have a Presentation and I have the Presentation that has the 

information that I need.  So what I’m going to do is I’m going to go to the, sorry, I’m going to go 

and I’m going to go to the Presentation that has the Content.  What I’m going to do is I’m going 

to Select All.  I’m going to go Edit, Copy.  I’m going to flip over to the Presentation and I’m 

going to go Edit, Paste.  And I don’t want to use the Destination Theme.  I want to keep the, I 

don’t want to use the Source Formatting.  I want to use the Destination.  So what I do is I Copy it 

there and you’ll notice that I have an extra Slide at the beginning and all I do is Delete it and I 

now have added all of my Content from my original Presentation.  And it is now in not this 
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Presentation, it is in this Presentation.  And it has the Template that I want to use.  Now I may 

have to go and make adjustments to certain Slides or things like that, but basically this is how 

you can take an existing Presentation and change the Template that is used.  You simply Create a 

Blank Presentation with the Template you want and then you Copy and Paste the entire 

Presentation into it.  You will get one extra Slide at the beginning, you Delete that Slide, and you 

have your New Presentation with your New Template. 
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Video:  Working with Themes 

 
James:  Working with Themes.  Themes control the major details of your Presentation.  This 

includes WordArt, SmartArt, Tables, Shapes, and other Objects.  Most importantly Themes 

control the Layouts and the Backgrounds.  Themes have three major components; that is Theme 

Colors, Theme Fonts, and Theme Effects.  A Template has by definition a Default Theme.  You 

can Apply this Default Theme to one of the Standard Themes that come with PowerPoint.  You 

can adjust the Default Theme or newly assigned Theme for Color, Font, and Effects.  What I’m 

cautioning you about is do not let the Theme you select or create become the message of your 

Presentation.  It’s very easy to have a Theme that is so busy that people cannot hear what you’re 

saying; they’re watching the Presentation and nothing else.  Let me demonstrate. 

As mentioned in the Introduction, each Template that you assign to a Presentation has a built in 

Theme.  You can alter or change that Theme for individual Presentations based on the Template.  

To do that what you do is you go to the Design Tab and you have the Themes Group.  And so 

what you do is you have the, this Presentation and you have the built-in and you’ll notice that as 

you select one of the built-in, the underlying Slide changes.  If you want to test a Theme what 

you need to do is you need to Save the Current Theme so you can come back to it.  So we’re 

going to select the Current Theme and we’re going to call it Jigsaw because that was the 

Template.  And we’ll go and Save it.  And now what we can do is we can go and this is one that 

we thought there was a possibility for so what we’ll do is we’ll do that.  Well, we’ll see how it 

looks, but remember you make all of these decisions in the Slide Show View.  Okay?  And well, 

that’s not that effective so what we’ll do is possibly pick another.  You can spend time going 

through these various Themes to get the one that you actually want.  In our case, having tested 

them what we want is we want the original.  So since we Saved it as a Custom Theme we can go 

back and Assign it to the Presentation.  Now, each Theme is made up of three components.  It’s 

made up of the Theme Colors.  We’re going to look at those in detail.  It’s made up of the Theme 

Fonts.  We’ll look at those in detail.  And it’s made up of the Theme Effects.  We’ll look at those 

in detail.  So basically what you do is you look at the Colors and what you want is you can go 

through and as you go through you will notice that the underlying Slide changes.  Now you can 

go to Austin and you can say, well let’s see what Austin looks like.  So you can select Austin and 

then you can go back to Slide Sorter view and you can go and you can see what Austin looks 
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like.  Now the other thing you can do is you can actually, and this time I’m careful not to select a 

Title Slide, because you remember from the topic on Slide Management that the Title Layout is 

different than the Title and Content.  It’s a special Layout.  So I want to see what the Color 

Effects are on a particular Slide.  And so to do that what I actually do is I can go down here and I 

can go to Aspect, well let’s pick one that’s really different.  Let’s pick Apex and basically I can 

say Apply it to the selected Slide and you’ll notice that I now have two Slides using one Color 

Theme and one Slide using another.  The ultimate, the ultimate in terms of Color is to go down 

and to Create a New Theme and there are Text Background – dark, light, one, two, there are six 

Accents and there are two Hyperlink Color Aspects.  So basically a Color Theme in PowerPoint 

consists of 12 components.  We’re going to come back here when in the next chapter we talk 

about Hyperlinks and talk about the use of the Hyperlink and followed Hyperlink Color Scheme 

using the Theme Colors.  What you can do is if you want to change that to something else you 

can do that and you will notice that as you do it what happens is it actually shows you the various 

Slide components.  And we can say, “Another Jigsaw” and we can Save it.  And basically, you’ll 

notice that we applied it to All.  We can go up here and we can find our Apex again and what we 

can do is Apply it to the selected Slide.  And we can go up here and we can go and we can have a 

Gray Scale and we can Apply it to the selected Slide.  So basically, we can actually have a 

different Color Scheme for each Slide.  When we go down here and we go Home, New Slide, we 

get the overall Color Scheme that’s in effect and we can change those Slides that we want.  So 

we can actually use a different Background depending on, for example, we could have a special 

Background for Comparison Slides, as opposed to standard Content Slides.  You can work all of 

this out.  Alright, that is the Color.   

In terms of the Font, basically what you can do is you can decide whether you want to use a new 

Font and you can Apply to All Slides.  And you can, if you don’t like that, what you could do is 

you can Apply to All Slides.  So you can go through and change the Font.  Let’s look at the 

Fonts again just so that we understand that each Font is composed of two components and that is 

the, are the Body Font and the Heading Font.  If we want to see that what we can do is we can go 

down here and we can actually Create a new one.  And what we could do is we could take 

Stencil and we could take Algerian and we could call this Jigsaw, and we could Save it.  And 

basically then what we would do is we would have a Font and we could Apply it to All Slides.  

And there we have it.   
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Alright, the third component is the Effects component of the Theme.  And basically what the 

Effects do is this alters the Shapes, Pictures, and Charts that are used in your Presentation.  

These, again, are simply ways in which the various Objects that I have mentioned are going to be 

reflected in your Presentation.  My recommendation to you is, is that what you do is you don’t 

worry about the Effects until after you have Slides or at least one Slide which contains Shapes, 

Pictures, or Charts and then you come here and decide if you want to select a different Theme 

Effect for those Objects, because until you have the Objects, they are not actually going to be 

there.  The other thing that we can do is we can change the Background Style.  So basically what 

we could do is you will notice that we can within the Slides we have we can change the Style, 

and if we like that Style better.  You’ll notice that the Background is now using the same 

perspective for all of them.  And we could go here and we have the Background changes.  So 

what we can do is in addition to the Color, Fonts, and Effects what we could do is we can change 

the Background Style.  If you don’t like what is shown, you can actually Format the Background 

and this is where you can get into some spending a lot of time creating very precise 

Backgrounds.  And, for example, we’ll just take one and we will Apply it to All and we’ll Close, 

and we have a Custom Background that was applied.  The other thing that we can do with the 

Background is, is that we can, if necessary, Hide the Background Graphics.  So you’ll notice that 

in this case if we go down to this Slide here and for some reason these little Jigsaw pieces are 

actually Graphics, what we can do is we can actually say Hide the Background Graphics on this 

particular Slide.  And what we can do is the Background Graphics disappear and we have a Plain 

Slide based on the Background.  So we have total control over the way in which our Presentation 

is going to appear. 
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Chapter 4 – Beyond the Basics 

Video:  Introduction to Beyond Basics 

 
James:  Beyond the Basics.  The topics in this chapter are, first of all, Using Hyperlinks, then 

Working with ClipArt, Pictures, and Screenshots, then Multimedia, specifically the inclusion of 

Audio and/or Video Clips in you PowerPoint Presentation, talk about Animation, talk about 

Transitions.  Then we’re going to talk about the Compare and Merge of Presentations.  This is 

very powerful capability when other people are working with you on a Presentation and you 

want to compare their suggested changes with your original Presentation.  There are special 

capabilities available to do that in PowerPoint 2010.  And the last topic in this chapter will be 

Sharing between PowerPoint and other Office 2010 Applications.  Let me demonstrate. 
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Video:  Using Hyperlinks 

 
James:  Using Hyperlinks.  Hyperlinks allow you to Link your Presentation to other Files.  For 

example, if you wanted to in a Presentation to Link to an Excel Spreadsheet you could put in an 

Icon.  You could setup a Hyperlink to that particular File.  When you click the Icon, you would 

Open up the other File and you would be able to talk about the information that was in the Excel 

File.  You can also go to Non-Office Applications, but you will notice that Microsoft Office 

gives you a Security Warning.  If you trust the File, in this case we do, we would go Open it, and 

we would Open a .pdf File.  We could also Link to other Presentations.  We could Link to 

websites.  We can Link to an Email Address.  We can Link to another Slide in the Current 

Presentation.  Let me demonstrate. 

Start the demonstration of Hyperlinks by showing you how to use Hyperlinks to websites.  I’ve 

already started a page in my little Presentation called the Correct use of IP.  And basically what I 

want to do is to add a couple more Hyperlinks to show you how it works.  So basically what I do 

is I go into the Slide View and I decide where I want to Insert the Hyperlink.  I then go to the 

Insert Tab to the Links Group and what I do is select Hyperlink.  And you’ll notice that I can go 

to existing Files or web pages and we’ll look at this, places in this document.  I can actually 

create a New Document.  I can Link to Email Addresses.  We’re going to concentrate on these 

first two.  So basically in terms of the File or web page what I’m going to do is I’m going to go 

to Browse Pages.  Now here are the pages that I have Browsed.  I can actually go here and start 

the Browser and Browse to Find.  I personally find that it is more effective if I simply switch to 

my Browser Browse and when I get the right page what I do is I come back here.  So what I’m 

going to do is to switch to a Browser in which I have already located information on General 

Microsoft Trademark Guidelines.  I go up to the top and I simply say Copy it.  And I go back to 

my Presentation and you’ll notice that because I actually Copied it, it actually placed the 

information and it decided what to call this which was the Title of the page, which is General 

Microsoft Trademark Guidelines.  And so I say, OK.  And you’ll notice I now have General 

Microsoft Trademark Guidelines and then I’ve already entered one, which is Always PowerPoint 

with two capital P’s, not powerpoint.  And I’ve put in a Link.  But you’ll notice that the two 

Links are shown differently.  And we have the capability to show the Format the way in which 

the two Links are displayed.  This first one, the one that I just entered, is an unused Hyperlink, in 



Learn PowerPoint 2010 
 

© Copyright 2008-2012 Simon Sez IT, LLC. All Rights Reserved. 
 

other words we haven’t actually gone off and clicked it to follow it.  Okay?  And the second one 

down here, the one that’s in black, is a Followed Hyperlink, meaning that I have already used it.  

So to actually change the way in which these appear what I do is I go to the Design Tab and I go 

to the Themes and I look at the Color.  This whole idea of Themes and the three components of 

Themes was covered in a previous topic in the previous chapter.  So what I’m going to do is I’m 

going to go to Colors.  I’m going to go down to Create New Themes and you’ll notice that I have 

the Hyperlink unused and I have the Followed Hyperlink.  Well let’s change the Followed 

Hyperlink to be red and we’ll change this one to be white.  And we can give it a name or 

whatever we want and we can say Save it.  And basically, you will notice that we now have a 

white Link that has not been followed and we have a red Link that has been followed.  The other 

thing that I want to point out to you about Hyperlinks is that we could, if we wished, we could 

have another Hyperlink and what we could do is we could say, “About Microsoft”. And 

basically, in this one what we want to do is I’ll Move it in.  What we want to do is we want to 

have a Link to Generally About Microsoft.  And so what we could do is we could go here and 

what we would then do is we would then Insert a Hyperlink and basically we have the capability 

to enter down here, if you know what you’re doing, you can actually simply, okay, change this.  

So we can get rid of all of this.  And we can Delete there.  And we can just say 

www.microsoft.com and say OK.  And basically, since we haven’t gone there, this is a Hyperlink 

which has not yet been used.  Now, the other thing is, is that when you switch your Presentation 

into Slide Show, if you hover over one of these Links what you can do is you can actually click it 

and it will transfer control.  But a lot of people, if they simply want to give people information 

on a Hyperlink, for example, they want people to know how to find Microsoft.  What they do is, 

is that they change the Hyperlink so that it simply becomes Text.  So what I’m doing is I’m 

selecting the www.microsoft.com.  I’m going to the Home Tab Links Group and what I’m doing 

is I’m going down to the Browse Pages and you’ll notice it’s highlighted what I have 

highlighted.  And I’m going to click on Remove the Link.  Now I still have the direct address of 

that website, but in this case during the Presentation if I accidentally hover or I accidentally 

hover or click on top of www.microsoft.com, I’m not actually going to go off by accident to that 

site.  So you have to decide whether you want your Hyperlinks to be Active and be selectable 

and allow control or whether you simply want to inform people as to the Hyperlink Address, the 

URL so they can go to that particular place following the Presentation when they have time.  

http://www.microsoft.com/
http://www.microsoft.com/
http://www.microsoft.com/
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Now let’s switch and talk about how we Link our Presentation to other Files.  So I have another 

Slide here called Supporting Files and we’re going to look at two options.  One is to go to an 

Excel File and one is to go to a .pdf File.  This basically is a detailed instruction of what was 

shown in the Introduction. So basically in terms of an Excel File, we can simply select the word 

Excel, for example.  We can go to Insert and we can go to Hyperlinks and basically what we can 

do is we can go to Recent Files.  And what we can do is we can actually find the File.  Now if 

you’ve got a lot of Files, as I have, one of the things that you can do is that you can actually 

Browse for the File.  And so I happen to know that it’s in PowerPoint stuff.  And here is a 

sample, Excel, and I select it and I can say Text to Display is Excel.  And I say OK.  And 

basically I now have a Link.  I will switch to Slide Show and I will go up to Excel and basically 

what is going to happen is, is that the PowerPoint will Open the Excel File.  And here is the 

Excel File that we pointed at and we could now talk about the Excel information relative to our 

Presentation.  One of the things that you have to plan in your development of the Presentation 

when you are Linking to Files and that is how you’re going to get back to the PowerPoint 

Presentation.   

One of the ways is to use the Alt-Tab feature and basically what you do is you go back to the 

PowerPoint Presentation.  You’ll notice that when you’re in Slide Show Mode, you actually have 

two PowerPoint Presentations.  One of which will bring you back into the Slide Show if you 

accidentally as I did, come back here.  You’ll notice that you always have a button that is for 

Resume the Slide Show and basically what you can do is Resume the Slide Show.  I’m going to 

go back to the Slide Creation View, the Slide Pane.  Now, the thing that’s different about this 

than the Introduction is that I did not use an Icon.  You do not have to use an Icon to Link to a 

File.  What you can do is you can simply choose a particular piece of Text and you can use that.  

The same thing with the .pdf.  What I will do is I will do that.  I will Create a Link.  I will go to 

Recent Files and I will again Browse simply because I have a lot of Files.  And what I need to do 

is to find a .pdf File and when I find the particular .pdf File that I want I simply select it.  You’ll 

notice that we have the ability to change the displayed Text, but in our case we’re actually 

simply selecting the Text so we will simply leave it there.  It gives the Address of the File so 

what we do is we say OK.  Again, what we’ll do is switch to Slide Show and you’ll notice that 

this one is white because we haven’t used it yet.  When we click it you’ll notice that you get this 

Warning.  The Warning is provided or created or generated by Microsoft Office for any File 
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which it, a Microsoft Office Application Software did not Create.  This is not to say that you 

can’t go ahead.  This is just part of the Microsoft Security and so what you do is you say, OK.  

And when you’re doing a Presentation what you need to do is to understand that this is going to 

happen.  You don’t have to actually Pause during the Presentation.  What you do is you simply 

click OK and you go on.  But be prepared for the fact that it will appear. Again, what we have 

with this is we have to get back.  What we do is we go back to our Presentation and we’re back 

into our PowerPoint Presentation.  Now what we want to cover is the capability for Linking 

within our Presentation.  Linking to other Files, that is sometimes helpful.  Linking to websites, 

that is sometimes helpful.  But one of the things that really powerful in a lot of Presentations 

developed with PowerPoint is the ability to Link so that you don’t have to go through the Slides 

in a sequential order.  This is especially critical if you know that there’s the possibility that 

you’re going to be asked for more explanation for a specific point or you may not be asked for an 

explanation.  So what you can do is you can use two capabilities within PowerPoint to solve this 

problem.  What you can do is you can Create a Slide or Slides and then what you do is you can 

Hide them.  Okay?  Now a Hidden Slide is simply a Slide that’s part of the Presentation, but 

when we’re going through the Slide Show it is not Displayed.  I’m going to go up to Slide 11.  

I’m going to go from Slide 11 and I’m going to go to the next one which is Presentations and 

People’s Memory.  And you’ll notice that, that happens to be Slide 13.  So the Slide marked 12 

was not Presented as I went through the Presentation.  So what we want to be able to do is we 

want to be able to Link from this Slide to a Slide that talks about more about organization.  Now 

we have some options.  One is that we could simply pick a word and Link from the word.  But 

the word that we chose or selected would be shown as a Hyperlink.  Now PowerPoint has solved 

that dilemma for us because what they have provided is, they have provided Action Buttons.  So 

what we do is we go to Insert, Tab, Illustrations, Shapes.  Now the whole subject of Shapes and 

working with Shapes was covered in a separate topic in the previous chapter.  But what we’re 

going to do is to look at a very specific type of Shape.  So what we do is we Open up the Shape 

and we go down to the bottom to where we have Action Buttons.  And you’ll notice that we have 

Action Buttons that are indicating of going Back or Previous, Forward or Next, going to the 

beginning, going to the end, going Home, going to Information, returning, going to a movie, 

going to a document, going to a sound, or going to Help, or we just have a Custom one.  So what 

we’re going to do is let’s select the Information.  What we’re going to do is we’re going to Insert 
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the Information Button.  And we will Insert it here.  Now you’ll notice that when we Insert an 

Action Button we get Action Settings.  What we want to do is what happens when we go to the 

Action Button and we click on it.  So in our case what we’re going to do is we’re going to 

Hyperlink To.  And now in our case it is the Next Slide, but it doesn’t have to be.  I simply 

placed the Hidden Slide following so I could very easily Move from one to the other.  You can 

actually place, and a lot of people do this, they place all of their Hidden Slides at the end of the 

Presentation.  And so therefore we can go and we can specifically say we want to go to Slide and 

basically what we can do is we can go and we can find and you’ll notice that the Hidden Slides 

are indicated by brackets around the Slide Number.  So we say More Details on Organization 

and we can say OK.  Now we could also Run a Program.  We could Run a Macro.  We could 

actually Play a Sound if we want.  We have all kinds of information.  The other thing that we can 

do is we can also indicate what we want to happen if we have the mouse simply over the Action 

Button.  Now in this case it is None.  We could Play a Sound to warn us or whatever we want it 

to do.  But basically what you have to do is you can actually go and Hyperlink to a Slide.  You 

can decide whether you want to have something happen on the mouse over capability or you 

want to have it on the mouse click.   

My recommendation to you is that for Links, Hyperlinks within a PowerPoint Presentation, you 

always make it a click; so therefore you don’t accidentally go to the Hidden Slide when you 

don’t want to.  So what we’re going to do is we’re going to say OK.  Now the other thing that we 

can do is we can select that particular Action Button and what we can do is we can Format it.  

And basically what we could do is we can change the Fill so we have a Gradient Fill.  We’ll 

make it a little less stand out.  We’ll do indigo.  And we can make it Rectangular.  We can have 

the Line Color.  We could have just to contrast.  So basically what you can do is you can go and 

Format the Action Button just the way you can any other Shape in a PowerPoint Presentation.  

When you’re happy with the Formatting you Close it.  There you have the information.  Now, 

you have to decide where you want to place this on your Slide.  You can place it anywhere that 

there is space.  In our case, let’s be simple and we’ll put it at the bottom.  Now what we do is 

we’re going to switch to Slide Show and basically we’re talking along and we perceive or we’re 

asked a question about the Organization of Material and so what we do is we now have gone to 

the Hidden Slide.  Now, the thing about going to Hidden Slides is you have to get back to where 

you came from.  So in our case what I have already done simply in the interest in time is I have 
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put in an Action Button which is going to return us to the Slide “How to Organize the Material”.  

So I have this button down here, the Information Button, which takes me to this Slide.  And 

basically I go back to this Slide.  Now I’m going to Escape and I’m going to explain something 

to you.  If basically I had when I came to this Slide on More Details on Organization, say that 

what I wanted to do is have three Slides.  It’s a very detailed, complex explanation that I want to 

give.  One of the things is, is that I would need to do is on the first Hidden Slide I would need to 

have an Action Button that went to the next Hidden Slide and on the second Hidden Slide I 

would go to the third Hidden Slide and on the third Hidden Slide I would want to return.  There’s 

another scenario, all of which PowerPoint suggests and supports quite easily.  I have three 

Hidden Slides.  I want to always go to the first and at the end of the first I always want to go to 

the second.  But on the second I may decide that I don’t need the third.  So therefore I would 

have two Action Buttons, one which goes to the third Hidden Slide and one which returns me to 

the original Presentation.  So you can use Hidden Slides, place them anyplace in your 

Presentation you want, and then you can use Action Buttons to actually have a Presentation that 

if necessary you can go off and explain in more detail. 
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Video:  Working with Clips, Pictures, & Screenshots 

 
James:  Working with ClipArt, Pictures, and Screenshots.  We’re going to, first of all talk, about 

working with ClipArt, what it is, how to Insert it, how to manipulate it, how to use it in your 

Presentation.  We’re then going to talk about Pictures.  I want to mention very briefly that you 

need the permission of the person who owns the Copyright for Copyrighted Pictures before you 

can Embed them or use them in your Presentation.  In this case, this is a Picture that I took, so 

therefore I do not need anybody else’s permission to use the Picture.  We’re also going to talk 

about including Screenshots in your Presentation.  Now this is not Screenshot Software.  This is 

the Screenshot capability that exists within PowerPoint 2010.  Let me demonstrate. 

PowerPoint ships with an extensive set of ClipArt that you can Insert in any Slide.  The first 

thing you have to do is decide which Slide you want to Insert it in.  We’re going to Insert our 

first ClipArt into this particular Slide called Presentation.  And basically to Insert ClipArt, you 

go to the Insert Tab to the Images Group and what you do is you select ClipArt.  Now, by 

Default you are going to get all of the Images that are available.  If you know the general area of 

the Image that you are looking for, then what you do is you can Search for it.  So what we want 

to do is we want to Insert some ClipArt for about people because people make Presentations to 

people.  So we type in People and we say Go and what we do is it has taken all of the ClipArt 

that’s available and what it has done is it has given us a ClipArt on People.  Okay.  So what we 

want to do is we want to show the Presentations present ideas.  So we will click and the ClipArt 

is now into the Slide.  Now you can leave this Open if you’re going to keep coming back and 

forth, but just to make it easier I’m going to, I’m going to Close the ClipArt.  And so what we 

have is we have the screen.  So now the first thing you have to do is you have to organize the 

Text, assuming you already have Text relative to the ClipArt.  In this case, it’s going to be quite 

simple because we can Move the ClipArt over there and we can select the Text and what we can 

do is we can Move and Resize the Text Box so that it is, does not extend beyond the ClipArt.  

And now we have the ClipArt.  Now, once we have got the basic ClipArt into our Slide, we can 

now proceed to Format the ClipArt.  And you’ll notice that when we select the ClipArt, we get 

the Picture Tools Context Tab with the Format Tab and this is where we can go to deal with our 

ClipArt.  Now don’t be confused.  We have the same capabilities for ClipArt as we have for 

Pictures.  In PowerPoint ClipArt and Pictures are Formatted the same.  The difference is, is that 
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ClipArt ships and there are Pictures are things that you and I take or you and I get and put into 

our Presentations.   

Now, the first thing we can do is we can decide how basically we want to display the ClipArt.  

So we go to Picture/ClipArt Styles and what we do is we Open it up and you’ll notice that as we 

go through and choose, what happens is when we choose a particular Style, the ClipArt changes 

to take on the Style that we have selected.  So what we can do is we can go through and we can 

decide which is the best way of presenting the ClipArt.  And let’s get one with a Border.  And 

this has got a black Border.  Okay.  So what we’ll do is we’ll select that.  Now, that is the 

Application of a specific Style.  Now what we can do is we can fine tune that because we have 

three capabilities relative to the Picture Style.  One is, is that we have the Picture Border and so, 

for example, if we don’t like a black Border and we want a red Border we can have that.  If we 

want we can Open it up and we can change the Weighting.  So we can change the Border that is 

around the particular Picture regardless of the Border that was actually used in the Style that we 

selected.  We can then go to Picture Effects.  And basically what we can do is we can have an 

Outer Shadow.  We can have a Reflection.  And you’ll notice that when we turn on the 

Reflection you can actually see the Reflection of the ClipArt below it.  Now, Reflection 

obviously takes more space than no Reflection.  And we can have Glow.  Now, again, not all of 

these Effects will work depending on the Picture Style that you select.  As I have mentioned in 

other topics, the real way to observe the results of choosing a Picture Style, Picture Border, 

Picture Effects is to go to Slide Show.  And basically when you go to Slide Show, you will see 

that we have a Glow, we have a red Border and we have a Reflection.  Question is, Do you like 

that?  Or do you not like it?  But the real place to look is not when you’re building the Slide, but 

when you are in the Slide Show.  So what we’ll do is we’ll go back to the Picture Layout.  Now, 

what we can do is we can Convert this Picture Layout to a SmartArt Shape.  There is an entire 

topic in this Presentation that talked about SmartArt.  One of the points that was made is that 

many of the SmartArt Shapes have places for Pictures.  You can actually Insert the Picture into a 

SmartArt.  So when you are working with SmartArt you can put ClipArt, Pictures into SmartArt.  

So basically what we’ve done is we have got our ClipArt.  Let’s go to another Slide and what 

we’ll do is we will Insert another ClipArt and show you some other capabilities that you have 

with the ClipArt.  So we go to Insert, we go to ClipArt, and basically what we do is we want to 

have Cartoons, and we go Go.  And basically what it’s doing is it’s Searching for Cartoons 
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within the ClipArt.  And eventually it will show you a list of all of the Cartoons that are 

available.  Not everybody thinks that all of these are Cartoons, but that’s okay.  What we could 

do is we can decide which one we want, and let’s put one that has that on it, alright?  So what 

we’re going to do is we’re going to Move this over to the side just as we did before and we’re 

going to adjust the amount that is devoted to Text.  And we’ll go back to the original Text Size.  

And again I’m going to Close the ClipArt so that I can look at the actual just the Slide itself.  

Now, again, we go when we select the ClipArt, we have the Picture Tools Format Tab and we 

have the Picture Style.  One of the things that we can actually do is we can actually Crop the 

Picture.  If we don’t want all of the particular part of the ClipArt or the Picture, we can bring the 

whole Picture or ClipArt in and we can Crop it.  And what we could do is we can select the Crop 

Tool and basically what we could then do is we’re now in the position to Crop it.  So we can 

Crop it to a Shape.  These are the standard Shapes that we talked about before.  And we will 

Crop it so that it is up high and basically we do that.  We go, No that’s probably not what we 

want.  So what we’ll do is we will Crop and we’ll go back to a Shape and let’s put it into a 

Hexagon.  Okay.  So you can actually take and Crop your ClipArt so that it takes on any Shape 

you want.  The other thing that you can do is you can actually change the Size and you can do 

this.  Now, you’ll notice that when I change the Size, the Size is shown up here.  Some people, 

it’s entirely up to you, some people feel that all of their ClipArt or Pictures should be of the same 

Size in a Presentation.  So therefore what we could do is we could decide that we want all of our 

ClipArt to be 2.7 inches by 2 inches.  Okay?  And basically, you’ll notice that what we do is in 

this case we are, when we change one dimension we change the other.  So therefore what we do 

is to actually be able to change one Size without the other what we do is we go to the Size and 

Position. We have a Menu of choices. So what we do is we select that and basically when we 

have the Size, you’ll notice that what we can do is we can change it so that it is no longer Locked 

to the original Picture Size.  And so what we can do is we can say we want this to be 2.7 by 2 

inches or 2.1 or whatever we want and basically we can change the Size.   

Now, this Menu of Format the Picture Options we got from the Size.  Okay?  The Size Category.  

We can also get it from the actual Picture Styles and this is where we can change the Fill.  And 

again, we can spend a lot of time on Fill.  We can have a Shadow and basically we can have a 

Reflection.  And we can have Glow, 3-D Format, and we can have 3-D Rotation.  And again, just 

like the Shapes that we talked about previously, not all of the Options are applicable, but 



Learn PowerPoint 2010 
 

© Copyright 2008-2012 Simon Sez IT, LLC. All Rights Reserved. 
 

basically what you can come is you can come here and you can decide what you want to do in 

terms of Formatting the Picture/ClipArt and you will be able to see what you want is.  You’ll 

notice that, in this case, there are no Artistic Effects available.  That’s because it’s ClipArt.  If it 

was a Picture, we will show you in a minute, we would actually have Artistic Effects.  Here is 

where we can Crop.  Here is where we can Size.  Here is where we can Position it.  So, again, if 

we want to have a very precise Position on a Slide for all of our ClipArt then what we can do is 

we can set it in this case, and in this case we are always going to be at a Vertical 2 inches from 

the top left corner and 7.5 inches Horizontal.  Now, if we wanted to change this relative to the 

Center we could also do that.  So you can have the Position relative to the Center or relative to 

the top left corner, you choose.  And this is not a Text Box so obviously we can’t lay out the 

Text Box, but if it was a Text Box then we would be able to actually layout the Text Box.  So 

basically what we can do is we have total control over our ClipArt.  Now let’s briefly talk about 

Pictures, but the thing to remember is, is that all of the Formatting that I did for ClipArt also 

applies to Pictures.  So to Insert Pictures you go to the Insert Tab to the Images Category and you 

select Pictures.  And you are given a display of the Pictures that are on your computer.  And we 

will Open up the Australian Picture and what we’ll do is we will put in a Picture of the Sydney 

Opera House.  Now again as I mentioned at the beginning one of the things that you want to be 

sure of is that you have permission to use Pictures.  These are Pictures that I took and therefore I 

have my permission of myself to use them.  You’ll notice that in a lot of cases Pictures are very 

big.  What we can do is we can make major adjustments in Size simply by Grabbing the Picture 

Holder side Handles and adjusting so that we have a Shape.  And again what we can do is we can 

adjust, sorry, wrong one, we can adjust the Text so that it fits around the Picture.  And we can 

actually go as close as we possibly can.  And there we have our Picture in our Slide.  Now again, 

when we select the Slide we go to Picture Tools Format and what we have is, again, the same 

capabilities as we had before.  We can change the way in which the Picture is displayed.  You’ll 

notice that we now have Adjustments because this is a Picture.  What we can do is we could have 

Artist Effects and what it does is it actually takes your Picture and shows you what it’s going to 

look like with Artistic Effects.  So what we can do is we can go and sort of have it less 

pronounced with a Background.  If we don’t like that what we can do is we can go and put a Grid 

on top of it.  And basically what we can do is we can decide which Artistic Effect we want in 

case this turns a Colored Picture into a Black and White Picture.  We also have the capability to 
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select a Border.  And we also have the capability to have the Picture Effects, Picture Layout.  We 

can Crop it.  So basically the same Effects are available on a Picture as ClipArt.  In a subsequent 

topic of this chapter, I’m going to discuss Animation and the real power of Pictures is to have 

Animated Pictures.  Now, we can have simple Animation, as I will show you in the Animation 

topic, or what we can do is Microsoft have provided some very sophisticated Animated Picture 

capabilities in a Template that you can Download and I will give you the address at the end of 

this topic, but basically what I want to do is quickly show you what I am talking about.  And so 

basically this is the File and we’ll switch to Slide Show View.  And you’ll notice that this, the 

Picture actually changes within the Frame.  We go to another one and we have the capabilities of 

having it in a Frame.  You’ll notice that this, the sides of the Cube change to various Flowers.  

And this is one of my personal favorites, and basically what you can do is you have all of these 

Animated Effects that you can have for your Pictures.  Now, again, and this was covered in a 

previous topic, all of the information about how you do this is in the Notes section of the Slide.  

So Custom Animation Effects, Picture Series with Motion Pass, basically it tells you exactly how 

to do it.  The other thing is, is that by Downloading this Template, you are authorized to use 

these Pictures by Microsoft; so, a very sophisticated way of having Animated Pictures in your 

Presentation.   

Now, what we want to do now is to talk about ClipArt or Screenshots.  Now, I’m not talking 

about the use of Screenshots or ClipArt with special software.  I’m talking about the ability that 

exists within PowerPoint to actually do a Screenshot.  So this is going to Insert a Picture of any 

program that is not Minimized to the Task Bar.  And so you’ll notice that, in my case, I have the 

previous available Windows.  Okay?  And basically all of the Windows that I want and this 

happens to be a Window in which I am storing this training.  So therefore you’ll notice that I 

now have this available.  And now I can do exactly the same as I did with the ClipArt or the 

Picture.  For example, what I could do is I can Crop the Picture and I can Crop it to a Shape.  

And I can take out what I want and I have the same capabilities.  I can go over here and I can 

change the Style, the Artistic Effects.  Again, I can have an Artistic Effect, that.  So basically all 

I have to do, again, to have this work is to have the program not Minimized.  I have to have the 

program Open and whatever is being displayed in that program is what the Screenshot is going to 

be.  So, for example, again I have two options.  I have my Animated Pictures and I have my 

Slides organized and displayed in the Folder.  So I can choose whichever one I want.  So, I 
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wanted to do that, I would now have another Screenshot that I could go and work with in my 

Presentation.  We can have ClipArt, we can have Pictures, and we can have Screenshots.  This is 

a little big Screenshot.  So what I’m going to do is just get rid of it and go back to the one that I 

had before; lots of capability to enhance your Presentation.  I mentioned in the demonstration, 

Microsoft supplies a Template of Animated Pictures.  To Download this for yourself you go to 

Microsoft.com and you Search for Free Animated Pictures.  You want to put in the word Free so 

that the right entry will be the second.  And it states Free Animated Picture Effects Template for 

PowerPoint 2007.  Again, don’t worry about the fact that it says 2007, it works perfectly with 

2010.  You select Download.  This is what the screen looks like.  If you’re having any problems 

this is the specific URL to the Download page. 
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Video:  Multimedia:  Audio & Video 

 

James:  In this topic, we’re going to cover the use of Audio and Video in your Presentation.  

You can include Audio clips in your Presentation.  (Piano Music Playing Happy Birthday to 

You) You can turn them on and off.  And you can also include Video in your Presentation.  And 

one of the things about Video is, is that you can have it so that it appears Full Screen.  And again, 

when you wanted to Stop it you simply Stop it and then you can go back to the normal Slide 

Presentation.  Let me demonstrate. 

Insert Audio or Video into our Presentation, we select the Slide on which we want to place the 

trigger for the Audio or Video.  We then go to the Insert Tab and you’ll notice that way over on 

the right we have the Audio and Video Options.  Let me start with the Audio.  So we can have 

Audio from a File.  This is, this is Audio that is, that is Recorded that we have permission to use.  

There’s also a ClipArt Audio and there is Audio that we Record.  They all once they get in there 

are basically the same, so we will simply select ClipArt Audio.  And basically what we have is 

this is Audio that was provided as part of PowerPoint by Microsoft and when you hover over it 

you will notice that it tells you how long and it’s going to, for example, we have Monkey 

Screams for five seconds.  It doesn’t matter which one of them we want.  We can have the 

Audio, okay, will be played for as long as want.  We’ll show you that.  So what we’ll do is we’ll 

put the babies laugh into the Presentation, and there is the Audio.  It may take a moment for it to 

come in.  You’ll notice that what we do is we have a representation of Audio and we have a 

Playback Control.  The other thing that you will notice is, is that when we have the Audio 

selected we have two Context Menus.  We have the Format and we have the Playback.  And 

basically everything that we talked about in the previous topic in terms of ClipArt, Pictures, and 

Screenshots apply in terms of Formatting the way in which the Audio Icon is going to be 

displayed.  So basically what we can do is we can now look at the part that is different and that 

is, is that within Audio Tools we have Playback capabilities.  So, for example, we can actually 

go in and trim the Audio.  We can Fade.  So we can Fade it in or Fade it out.  We can determine 

exactly what is going to cause the Audio to Play.  So, for example, what we can do is we could 

have it on Click.  We could have it Play Automatically when the Slide or we could have it Play 

across the Slides.  We can Loop until Stop.  If it is the type of Audio that we have Recorded we 

can Rewind after playing so we can Play it again.  We have control over the actual playing of the 
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Audio.  And just to show you what happens when you go into Slide Show.  What you will see is 

we have the actual Icon for the Audio is shown.  And basically when we highlight the Icon, we 

get the ability to Start the playing of the Icon.  It doesn’t last for very long, but basically what 

you do is, is that you can in my experience the best way is to simply do it on a Click and 

basically it will Play.  So basically that’s how you Insert Audio into a PowerPoint Presentation.  

We’ll push this one aside and we’ll now talk about the Inserting of Video.  We have Video from 

a File, Video from a website, or Video from ClipArt.  I should mention that the ClipArt Video 

does not contain Audio.  It is simply Animated ClipArt that moves.  And what we want to do is 

we’re going to Insert the Video from a File.  And so we have this Formula 1 Ferrari Launch and 

we will Insert it.  Now again it will take a moment for this to appear.  And we now have this 

screen in which the Video is going to be played.  It is possible and my recommendation is, is that 

for most PowerPoint Presentations what you want to do is you want to Play the Video Full 

Screen.  So therefore when we select the Video in terms of Formatting, basically, all we’re doing 

is Formatting the Icon that is going to sit there until we decide to Play it, alright?  So what we 

can do is we can do that and then what we can do is we can go to the Playback Tab and this is 

where we can Play in Full Screen.  Again, we can actually Trim the Video.  We can Fade it in, 

Fade it out.  We can adjust the Volume.  We can determine what’s going to cause it to start.  So 

we can have it Start Automatically when the screen is displayed or on a Click.  We can Play Full 

Screen and this is my recommendation, especially if you are making a Presentation to a large 

group.  If you have a little bit of Video in the corner of a screen people can’t see it.  So what you 

want to do is to have it Play Full Screen.  You would just go there.  You could also Loop until 

Stopped.  This could be a Video that you’re going to have in the middle of a Presentation when 

you take a break and you can Loop the, you can Loop it until it’s Stopped.  Again, you can 

Rewind it after Playing.  So basically you have the capability to control the Format of the Video.  

That’s the way in which the Icon is going to appear.  The Format is how the Icon is going to 

appear and the Playback controls how the actual Playback of the Video is going to occur.  And 

basically when we go into the Slide Show what we have is we have our Audio and we have our 

Video and we are in control of what we want. 
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Video:  Animation 

 
James:  In this topic, we’re going to talk about Animation, how to Animate the Objects in your 

Presentation, and you will notice that Animation can be a distraction from your message if 

you’re not careful.  There is numerous ways in which you can have Objects appear.  These are 

but a couple.  The Animation Effects fall into four Categories.  There’s the Entrance Effects, the 

Emphasis Effects, the Exit Effects, and the Motion Path Effects.  Let me demonstrate. 

In the Introduction, Animation allows you to control the way in which the Objects in a Slide 

appear.  Right now if we display this Slide in Slide Show Mode, all of the information, all of the 

Text, everything, including our two little ClipArt, are displayed at the same time.  We can use 

Animation to focus on portions of our Presentation.  Let me show you how that happens.  So the 

first thing we do is to select one of the Objects.  My personal preference, but you can certainly 

develop your own approach, my personal preference is if there is Text on the screen I always 

Animate the Text and then I determine how I want to Animate the other components.  So in this 

case, I’m going to Animate the Text.  And to do that I go to the Animations Tab and you’ll 

notice that I have no Animation, which is the Default.  I have these four Options, but if I Open 

up the More you’ll notice that I have more Options and if I don’t like those I have more than the 

More.  Now remember, we’re starting off talking about the Entrances.  So we’ll go to the 

Entrance and you’ll notice that I have a whole series of ways in which I can have the Object 

appear.  I’m going to start and simply select Dissolve In.  And so what we will do is we will 

Dissolve In.  Now, that is going to give us a certain level of Animation and one of the things as 

you become more proficient or you will be able to miss this step, but in the beginning what you 

want to do is you want to see what’s actually happening.  So therefore, you will notice that it was 

pretty good; we got the term Presentation, we got the Dictionary, but it all came in at once.  So 

let me show you how we can actually go in and adjust the basic Animation.  And to do that what 

we do is turn on the Animation Pane and basically what it does is it now gives us all of the 

Current Object.  And when we select an Object what it does is it tells us exactly what’s going to 

Start the Animation and what’s going to be the Duration of the Animation.  And so, for example, 

again this is just personally my approach, what I always do is I Animate the first Object in a Text 

Box after the previous.  So it’s now going to come in slightly behind the Title and basically then 

the On Click is going to be for Dictionary, but if I want to you will notice that the Default is all 



Learn PowerPoint 2010 
 

© Copyright 2008-2012 Simon Sez IT, LLC. All Rights Reserved. 
 

of the second level Objects come in at the same time.  But again, I can go in and change that and, 

in fact, I can change all of them by simply selecting multiple Objects. And I can go On Click and 

just to see the changes that have occurred I go into Slide Show and you’ll notice that the term 

Presentation is there, but it came in slightly after the Title.  Now when I press the mouse, I get 

the Dictionary.com defines it as an act of, state of, or demonstration or lecture or welcome.  So I 

can go through and now talk about each one of these points in turn to help focus the audience on 

the content of the Slide as opposed to giving them all of the Slide and a lot of people are going to 

go off and read it. So basically I can do that.  Now, I don’t have to live with exactly the Default 

as is shown.  For example, when you select any component, you can Open up a drop down list 

and basically what you can do is you can look at the Effect Options and/or the Timing.  So 

therefore you can have it come in Medium Speed, you can Delay it, you can Repeat it, you can 

spend all kinds of time deciding on how you want this step to play out.  One of the things that 

you can do, in certain cases it’s very effective, and that is, is that you can have it come in by 

second level Paragraph, fifth level Paragraph, as one Object.  You can control exactly what you 

want.  You can also control whether you want a Sound played or not.  So if you want to have a 

Sound played you can Play a Sound.  And you can also determine whether you want the 

Animation what to occur.  So basically you can go and select More Colors and we’ll select 

something that’s close to the Background.  And we can Animate the Text by Word and we can 

Save that.  And now we have the first one come in just like it was before.  And now we have the 

Dictionary.com sort of Dissolves in and you’ll notice that as soon as we Click it Fades into the 

Background.  Now in this case that’s basically not what you want to do, but what I want you to 

understand is that you have this control.  So what you can do is, is that if you want to, for 

instance, go through a series of points, what you can do is, is you can go point, make it Fade, 

point, make it Fade, point, make it Fade, and so on.  Okay?  And basically you can go through in 

that way.  And again we did that by actually going and Opening up the Effect or Timing Options 

of the Animation Pane.  And if we go to the last one and one of the things that you need to be 

careful of is that you don’t accidentally, if you go over here and you select we want to do 

something with this last demonstration lecture or welcoming speech, you’ll notice if you select a 

portion of an Object in the Slide, in the Animation Pane you have selected all of them.  And if 

you went and did something it would apply to all of them.  So when you’re working with the 

Animation Pane, one of the things to be careful of is that you only have the Object with the 
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Placeholder contains multiple Objects, you only have the Object you want.  And so what we can 

do is we can go and we can change the way in which this one comes in.  And we can have it 

come in differently and you’ll notice that it does that.  Now incidentally we can actually Play the 

Animation without going into the Slide Show Mode.  So all we do is we do that.  And you’ll 

notice that it’s moving slowly through and there we now have it.  Okay?  We could go up here 

and we could select the Presentation and what we could do is we could say: What about 

Emphasis?  We could have a Bold Flash.  And basically to see what that does is we simply Play.  

And it didn’t add a lot.  If you don’t like what you have accomplished what you can do is you 

can go and change it back; so you Remove it.  And now what happens is it’s out of it at all and so 

we can simply go and we have got this Option.  So, you can spend a significant amount of time 

deciding exactly what you want to do with the Animation.  In terms of the Objects, what you can 

do is you can select the Object and now I have selected the little ClipArt with the light and 

basically what I can do is I can let’s say Swivel.  And you’ll notice that when you add a New 

Object to the list of Animation it always comes in at the bottom.  But what I can do is I can 

Move it to Reorder it.  So what I do is I simply go and say that I want this to do is to come in 

first, after the Presentation.  And I want it to come in after or with the previous and if I now Play, 

you’ll notice that I still haven’t dealt with the second ClipArt, but you’ll notice that I now have 

the idea coming in right after almost identical to the term Presentation has as its root.  So then I 

would go down here and what I would do is I would go: How do I want that to appear?  And let’s 

go and look at some Entrance Effects and some of them are exciting.  What we can do is 

Boomerang it in, and basically that is okay.  Now in this case, we have to decide where we want 

this ClipArt part relative to all of the information that is in the second point.  So what we could 

do is we could go, we’re going to have it come in after the Dictionary.com defines it as and what 

we could do is we could say After previous, but what we could do is we could Delay it.  And 

now when we Play it, now you watch the screen, and when we Play it.  So therefore there’s our 

little man comes in, now Dictionary.com comes in, and you’ll notice that as the others come in 

the Goal Bounced in.  Okay?  And basically if you want any of these to be Delayed, all you have 

to do is change the Delay.  So we could go and sorry I clicked it, I Stopped it.  And you’ll notice 

that it now has this; we have our Goal Bounce in, we have the Act and so on.  Okay?  So 

basically you can go through and you can setup a process for Animation.  Now, I’m going to go 

down here and what I recommend that you do is that you have a basic approach to Animation, 
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because as I mentioned in the Introduction, you don’t want the Animation to become a 

distraction.  And so therefore, especially when you have a Presentation like this where you have 

predominantly blocks of Text that you want to talk against, what you in my experience, my 

recommendation is, is that what you should do is you should accept and define a standard 

approach and stick with that approach.  So, for example, if we wanted to what we could do is we 

could say we’re going to use a Fade approach.  Okay?  And basically what we could then do is 

we could then go over here and we could say our Default is, is that the first Object is always 

going to start after the previous.  The only other thing that we will do is, is that if we have got a 

point that we have specifically highlighted we will change the way in which it appears.  So, for 

example, in this case down here you’ll notice that we have Remember it is essential in red 

meaning that in our way of thinking about this Presentation, this point requires special emphasis.  

So what we could do is we could go over here and we can select the item and what we could do 

is we can have it change so that it Bounces in or if we want we could have it Zoom In.  But 

basically what we can do is we can change that one Object so that it is different.  And again we 

would decide where we want the ClipArt to appear.  We could have it Fly in.  And you’ll notice 

that we then decide when we want it to Fly in.  Well let’s have it Fly in after the opening one, but 

we will have it after the previous.  The other thing you will notice is, is that in some of these 

cases what we can do is we can go down here and we can have the Effect Option and you’ll 

notice that we go from the bottom, from the left, the right.  Now, again, if you have it from say 

the top left, this Object is going to cover what is already there as it goes across.  And in our case, 

we may want it to come in from the top or the right.  Well let’s say the top and basically we can 

say we want a Bounce End and we could do that.  And we can Play it.  And basically we have 

that Animation.  So there is lots of capability for you to Animate your Objects in each of your 

Slides.   

Now a couple of special cases of Animation that I want to talk about.  Here is a SmartArt that we 

created and we covered SmartArt in the previous chapter; there was a topic in a previous chapter.  

One of the things that we know about SmartArt is that it cannot be Animated.  SmartArt comes 

in all at once, unless, unless you actually work at it.  Now I’m going to show you that there is an 

Option and then I will explain to you how I achieved the Option.  So here is Know Your 

Audience.  Here is Know Your Audience 1.  Here is Know Your Audience 2.  Here is Know 

Your Audience 3.  Here is Know Your Audience 4.  So as opposed to having them come in all at 
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once, I actually built up the four parts of the SmartArt using Animation.  How did I do that?  

Basically what I did was I went to this Slide and I’ll only do one and I’ll do it quickly.  What I 

did is I simply Duplicated the Slide.  I went down to the new version of the Slide.  I went here 

and what I did is I Cut out.  Okay? And basically what I did is I ended up, sorry, I ended up with 

three points.  And so I took out the third point and you’ll notice that what I ended up with is a 

Slide that has one of the points, then two of the points, then three of the points, and then four of 

the points.  And then what I would do is I would actually then decide on this one here.  What I 

want it to do in terms of this.  The simplest one would be is, is to select this, go to the Animation, 

simply have it appear, have it appear after the previous, then go down here, and have it let us say 

Fade in.  And we will do it on a Click.  And so what we would do is we would go to the Slide 

Show.  And you could have a discussion about recapping the four points.  And then you could 

bring in the bottom line.  Now you’ll notice that when this one came in, it came in quite fast and 

so what we can do is we can make it a little slower.  And so that it’s sort of appears in slowly.  

And then we can go to the bottom line.  So by working at Animation you can control the way in 

which the information is presented to the audience for your participation.  I should mention that 

the same thing holds true that SmartArt appears all at once, so does a Table.  If you have a Table 

then the whole Table appears at once.  Again, the way to have a Table Animated and Animating 

Tables takes a lot of work.  But basically is, is to Duplicate the Slide, Delete all of the Rows 

except one, then keep the whole Slide keep and Delete all of the Rows but two and go through 

the Deletion.  It’s the same as the SmartArt.  It takes work, but it adds an Effect to your 

Presentation as opposed to all of them appearing at once. 
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Video:  Transitions 

 
James:  In this topic, were going to talk about Transitions.  Transitions are the Slide motions that 

occur only in Slide Show View when you are leaving one Slide and moving to the next.  It’s 

important to understand that you can have Hidden Slides that do not appear in the Slide Show 

View.  The aspects of Transition that we’re going to look at are the Directional Flow, the Speed 

at which the previous Slide leaves and the new one enters, and the capability to Add Sound to the 

actual Transition between Slides.  Transitions apply to the Slide selected in the Slide Pane or all 

Slides in the Presentation.  One little tip is that you can apply an overall Transition to the 

Presentation and then go back and Edit, change individual Slides.  You can also define the 

trigger that causes Slides to advance.  Let me demonstrate. 

Transitions, how we move from Slide to Slide. Very quickly.  In this particular Presentation, we 

display the first Slide.  We then go and we have Animation for the second Slide and so on, and 

that was covered in the previous topic.  And now observe carefully that when I leave this Slide 

the Animation, the Slide Content controlled by the Animation appears.  I have the capability to 

determine the way in which one Slide leaves and the next Slide appears.  Let’s see how we do 

that.  Now we can actually have Transitions and we can do them in the Normal View.  Again, my 

experience that I want to share with you is that at this point and time we’re not interested in the 

actual content or the way it’s going to appear.  That’s Animation.  I should incidentally mention 

that we can do Transitions followed by Animation or we can have Animation followed by 

Transitions.  There’s nothing that says you can’t apply Animation to a Slide to which you have 

all ready applied Transition and vice versa.  But my experience is that since all I want to do is 

look at the organization in terms of how the Slides appear, I’m going to Slide Sorter View.  And 

basically what I can do then is I can say: Okay, how would I like this particular Slide to leave 

and what is it going to do to the next one?  So what I could do is I can Transition to this Slide.  

Now some people don’t think that you need Transition on the first Slide and I will explain why.  

If I go to the Slide Show, most people start their Presentation with the first Slide showing.  So 

therefore the first time the Transition is going to be applicable is when they move to the second 

Slide.  But if you’re going to come up and start your Presentation without the first Slide there, 

then you may want to have Transition.  So whether you have Transition on the first Slide or not 

is entirely up to you.  Let’s go to the second Slide and what we’ll do is we will Push and 
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basically, we have you’ll notice that when we do that we actually see it.  We go to the third Slide 

and if we don’t like these we can see more.  Okay?  What we have is a whole series of ways in 

which the Slide will appear.  One of my personal favorites, I have no idea why.  It simply 

happens to be Shred, and you’ll notice that if we do that we see it.  Now this is another reason 

why it’s nice to do Transitions in the Slide Sorter because you can actually see what you want to 

do.  And so therefore what we can do is we can go down and have Doors, and there we have a 

Door.  And we have Effect Options, we can change it from Vertical to Horizontal and basically 

we can do that.  Now the other thing that we can do is we can Add Sound.  Okay?  Or we can 

have whatever Sound we want and we can determine the Duration.  And if we want a standard 

Transition, and this is something that in a big Presentation you may want to think about, and that 

is, is that what you can do is you can go to the Home. And you can select All and now if you go 

back to the Transition what you’re going to do is you are going to define the Transition for All of 

your Slides.  And so what we’ll do is we will decide that basically we want Uncover.  Now, we 

can then go and say Yes, but in this particular case what we want to do is we want and you’ll 

notice that it’s going through and doing the showing us how this works in our whole 

Presentation.  We can stop that by simply selecting.  So now what we can do is we can now go to 

this particular Slide and we can say this is one where we want it to be Shredded.  And this is one 

where we want it to, we can decide what we want.  Okay?  So we can decide exactly how we 

want this Slide to actually appear in our Presentation.  So we could do Checkerboard, alright?  

And so basically what we can do is we can go to the beginning and we can Preview the 

Transition and basically what happens is you’ll notice that we then Click and we can see what 

this one is.  And we can go to this one and we can Preview it and we can actually go through and 

Preview the Transition that we have on the various Slides.  Now I mentioned in the Introduction 

the use of Hidden Slides.  So if we go into this Presentation, you’ll notice that we have a Hidden 

Slide and the Hidden Slide is shown with a Line through the number.  So if we go and to see this 

clearly, we’re going to switch to Slide Show.  And so therefore we go from How to Organize the 

Material and basically we then go Presentations on People’s Memory.  And if we go back, you’ll 

notice that we did not go to the Slide called More Details on Organization; that’s a Hidden Slide.  

Now in the topic on Hyperlinks we talked about how to go from a visible Slide to a Hidden 

Slide.  If you simply want to Hide a Slide for whatever reason so that it is not there in terms of 

the Presentation, then basically what you can do is you can go to Slide Show and you can Hide 
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the Slide.  And if we go here to Presentations and People’s Memory, then we go to PowerPoint 

Slides and we have missed the other.  So you can decide what you want to do with Hidden Slides 

and they are not exposed during the Slide Show. 
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Video:  Compare & Merge Presentations 

 
James:  In this topic, we’re going to talk about Comparing and Merging Presentations.  You can 

Compare two versions of the same Presentation.  You designate which Presentation will be the 

final version, the one updated or changed.  I’m also going to include some suggestion for 

Reviewers, what you or they can do to make the Merging of Presentations easier.  Let me 

demonstrate. 

I’m going to start this demonstration playing the role of somebody who has been asked to 

Review this Presentation on Effective Presentations and once I have gone through that then I’m 

going to switch back to the Creator role and show how as the Creator I can take my original 

Presentation and I can Compare it against the one that the Reviewer created.  So, as the 

Reviewer, I’m assuming here that I haven’t worked on this Presentation, so one of the things I 

want to show you as the Reviewer is that it is very effective when you get a Presentation to 

Review that you get the overall impression of the Presentation.  And the easiest and quickest way 

to do that is in Outline Mode.  And basically, you can have Outline Mode and you can Expand 

All or you can Collapse All; you can decide how you want to do it.  My personal one is, is that 

what I like to do is I like to Collapse All and basically then I can simply Read or Review the 

Title of the Slide so I get an overall appreciation of the flow.  So therefore, we have Effective 

Presentations, we have something on Presentations, we have Why, Who, Know Your Audience.  

Hmm.  We have five Slides on Know Your Audience and then Know Your Audience 2, What to 

Present.  So basically what you can do is you can get a very quickly you can get an appreciation 

of the flow of the Presentation.  Then what you can do is you can now go back and start to enter 

specific Comments and/or make changes, and I will explain that there is a big difference in a 

moment.  So let’ first of all Add a Comment and the Comment is “Suggest that we change Title 

to be Creating Effective Presentations”.  And basically when we’ve done that, we can simply go 

and you will notice that it has a little Note and if we highlight the Note we can read it.  Now, the 

important thing about the Notes or the Comments is that when the person who asked us to 

Review gets our Presentation back they will be able to Read our Comments.  We can go down 

here and we can go, for example, and this is where you have to do, understand what is going to 

happen.  We can go down here and we can simply go and we’ve Deleted it.  And we’re going to 

now have two Presentations.  We have no idea as the Creator of the Presentation why we Deleted 
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that particular Object.  So what we could do is we could do a couple of things.  We could put in a 

Comment that says we Deleted it or I’m going to bring back the Object and what I’m going to do 

is I’m going to Add a New Comment that says “I suggest that it be Removed”, alright?  So, you 

can make direct changes or you can suggest changes.  So we’ll go down here and you’ll notice 

that in the original Presentation this was very intense.  Basically what we can do is we can go 

over here and we can change it to red and we can, if we’re really good, we can also change the 

Bullet Color to white and we have that, alright?  So, we can make the changes as we go through.  

We can change, we can Add New Sub-point.  We can make any and all changes that we wish in 

the Presentation.  In fact, we can go down here and we can go and we can go New Slide.  We can 

go and we can Reorganize the Slides.  We can go down into Slide Sorter View and we can go 

and Move this to here.  Now I’m not suggesting that this makes any sense at all.  I’m just saying 

that as the Reviewer, you can go through and make as many changes as you want.  And basically 

when the person gets the Reviewed or the Commented on Presentation back, if you have not 

included Notes they have no idea as to why you are making the change.  Okay?  So what you 

have to do is you have to decide what you want you do in terms of, we could have instead of 

simply changing that we could have gone to Review and we could go and we could say “New 

Format last too much”.  So basically you as the Reviewer get to decide what the changes were.  

You can also, obviously, Play the Presentation.  And basically you can go and you can get out of 

that and you can make a Note that says things like, “Change the Transition to be less to have less 

impact” and so on and so forth.  So basically you can add as many Comments or changes as you 

want and then what you do is you then Save your Presentation and then the person who asked 

you to Review takes your Reviewed and Compares it to the original.  So what I’m going to do is 

Pause for a moment.  I’m going to switch over to be the Creator.  I’m going to Open the original 

Presentation and then I will show you how to Open this Presentation, this version, and we can 

Compare the two. 

Alright, I have now switched so that I am showing the version of the Presentation that I sent out 

to be Reviewed.  To Compare this version to the Reviewed version, what I do is I select the 

Review Tab and I select Compare and basically what I do is I find the version that is the version 

that was Commented on.  And what I do is I now have the two Presentations side-by-side.  This 

is the revised one.  This is the original one.  The first point you will note is, is that I can see the 

Note and if I hover over the Note, you’ll notice that it says “James Bulmer suggested that we 
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change the Title to be Creating Effective Presentations”.  And basically what you can do is you 

can go down to this Note and you can, having read the Note, you can go Delete it and you can 

then say: Am I going to change it or not?  I will let you decide when you get the Comments of 

the Reviewer whether you’re going to follow them or not.  We’ll go down to the second Slide 

and you will notice that the second Slide has two Comments and basically what you can do is 

you can see the details.  Let me show you that you can also see the Slide.  So you have the choice 

in the Revisions portion of the Window to actually see what James Bulmer wants it to look like.  

And basically you’ll notice that here you can see the Comments.  Over here if you go to the 

Details then you have the Details, which is I suggested that this be Removed and number six is 

Change the Transition, Content Placeholder, and so on.  So you can either see what I’m 

suggesting or what you can do is you can see the Slide.  And what you can do is you can, if you 

go here, you can Accept all changes to the Current Slide and therefore the changes are made.  

You’ll notice that Accepting the changes does not Remove the Comments.  And so what I 

suggest you do is you can go and Delete the Comment and Delete the Comment and so on.  Then 

you go down to the next one and again what we can do is we can look at the Details and we can 

determine what we want to do.  And in this case, what we can do is we are going to simply go 

here to the Slide and we’re going to go Reject and therefore the Rejection is Reject all changes to 

the Current Slide and therefore none of the changes took effect.  Again, I have the Comment and 

basically I can Delete the Comments.  So basically you can go through Slide by Slide and you 

can see exactly what happens.  Now, here is what you see when there are no changes.  Okay?  

You’ll notice that no changes to this Slide.  The next set of changes is on Slide 15, which is very 

helpful because that means that what you can do is you can simply go down here to Slide 15 and 

see what the changes that you want are on Slide 15.  And there’s the Action Button changed and 

so on.  So what you can do is you can go through and it will tell you where there are changes and 

where there are no changes.  So basically it’s very easy for you as the originator to see what 

changes are suggested and to Accept or Reject the changes.  Now, I’m not going to take the time 

to Demo it, but I do want to mention the following.  If you want multiple people to Review your 

Presentation, basically all you do is when you get the first set of changes you go through and 

Apply then.  Then what you do is you can simply go here and you can go and End the Review 

and: Are you sure you want to End the Review?  And any changes, Unapplied changes will be 

discarded.  You say Yes.  Okay?  So what you do and then you get and you go and find the 
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second persons Revised Presentation and you do that.  You Open it up, you Apply the changes, 

you at the end you Exit and you can’t of multiple Presentations Open in the Slide Pane at the 

same time.  So you can’t have a second and a third.  So you can say, well this person suggested 

this and somebody else suggested something else.  What you do is, is that you have to do the 

original, an update from one, then the updated with the second, and so on. 
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Video:  Sharing with Other Office 2010 Applications 

 
James:  In this topic, we’re going to talk about Sharing with other Office 2010 Applications.  

For example, you can use Word Doc or Rich Text Format Data to Create a PowerPoint 

Presentation Outline.  You can use Tables created in Word or Excel as PowerPoint Tables.  You 

can Copy PowerPoint Slides into Word or Excel as a Picture.  The important thing to remember 

is, is that the Clipboard is Shared between all of the Microsoft Office Programs.  Anything can 

be Copied from one Application and Pasted into another Application using the Clipboard.  Let 

me demonstrate. 

In this demonstration, I will first of all Copy information from Word into PowerPoint and then 

take the resulting PowerPoint Object and Copy it back to Word.  I will then take an Excel Table 

and Embed it in PowerPoint so that when changes are made in Excel they will be reflected in 

PowerPoint.  And lastly, I will show you how you can use a Word Document to start a 

PowerPoint Presentation.  Now, we’re going to assume that we don’t have this Slide on Know 

Your Audience, but we have the information in a Word Document.  So what we’re going to do is 

Insert a New Slide and then what we’re going to do is we’re going to go over to Word and here 

is the information on Know Your Audience.  So we’re going to select it and then what we’re 

going to is we’re going to Copy it.  Then we’re going to go back to PowerPoint and not only are 

we going to Copy it, but we’re going to Copy into a SmartArt Graphic.  So we’re going to Open 

up SmartArt.  We’re going to go to Lists and we’re going to decide what type of SmartArt 

Graphic List we would like to use.  Here’s one that looks kind of neat called Vertical Curved List 

and we have these Bullets at the beginning and then we have a Curved List.  So we will say 

Curved List and we do that and we display the Text Pane.  And what we do is can go here and 

we can go Paste, and basically what we have done is we have Pasted the information from Word 

into PowerPoint.  We’re going to Close this.  We’re going to make some fairly quick but 

interesting changes in the SmartArt.  You’ll notice that we got two extra lines at the bottom.  So 

all we do is select those and we Cut them.  And we select the bottom one and we Cut it.  And we 

go Know Your Audience.  And basically, we have created a Know Your Audience Slide using 

Text from Word.  Now let me show you that we can do is we can go back the other way.  So 

what we’re going to do is we’re going to select the SmartArt Graphic Shape in PowerPoint and 

what we’re going to do is we’re going to Copy and then what we’re going to do is we’re going to 
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go back to Word.  And we’ll just go down slightly and basically what we will do is we will Paste 

using the same Format as PowerPoint and there we have an Object in Word which is a Duplicate 

of the information in PowerPoint.  Now there is no Linkage between these actual two Files; that 

the Word File and the PowerPoint.  We are just Copying, Pasting to make our life easier. So now 

what we’re going to do is we’re going to switch and work with Excel.  In the topic, on Tables we 

created a Table of Sales by Region.  What I want to show you now is, is that we can actually 

have the Table in Excel, maintain the Table in Excel, and actually Link the Table from Excel 

into PowerPoint.  So what I’ve done is I have created a New Blank Slide and I’m going to go 

over to Excel and here is our basic Sales by Region.  Now you’ll notice that in this case the 

major difference is, is that we actually have the Sales to the dollar as opposed to millions because 

when I was doing the Table in Excel I didn’t want to type all of those numbers.  But basically 

since they’re in Excel I don’t have to worry about that.  So what we do is we select the Table in 

Excel and what we do is we Copy, and then we go over here and what we do is we go Paste.  

Now you’ll notice that we have some Paste Options, and one is that we’re going to Embed the 

Excel Table in PowerPoint.  So what we’ve done is we have told it that we want to simply 

instead of just Copying the Data, we want to Embed it.  Now you’ll notice that this is an Object 

by itself because we can actually Delete the place for the Text and what we can do is we can 

make the Table bigger so that it stands out.  The other thing you’ll notice is, is that like most 

Tables, we don’t need the Slide Title.  So what we’ll do is we’ll get rid of the Slide Title because 

in the topic on Tables we said that in most Tables you put the Title right in the actual Table, so 

we have done that.  And we can also do some Formatting.  We’re not going to spend a lot of 

time, but what we could do is we could change the Background or something like that.  If we 

wanted we could go into an individual Cell and we could make changes.  Now, what I’m going 

to do now is I’m going to switch back to Excel, make some changes, and then I will come back 

to PowerPoint and show you.  I’ll show you the changes being made in Excel.  Then I’ll flip 

back to PowerPoint and show you how the changes are reflected in the PowerPoint Slide. 

Now, the way I’m going to make this change is I’m going to double click in the Table that is the 

Embedded Excel Object and what I’m doing is I’m going to make changes in the actual Excel 

Data.  And if I went over here and it turned out that this should have been 19 million, I will make 

the change there.  I can also make other changes in there and basically what I can do is I can 

make the changes.  You’ll notice that I am in Excel because I have the Sheets down at the 
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bottom, and basically when I go there I have made the changes and this is now 19 million and 

Washington is in red.  So basically what I’ve done is I’ve put an Object into PowerPoint which is 

an Excel Object.  When I click in the Object, it Opens up in its original software, which is Excel 

and I can make changes in the original Excel Data that is now an Object in my PowerPoint 

Presentation.  For the last part of this Sharing of information between the various Office 

Applications, what I’m going to do is I’m going to use an Outline that was created in Word and 

use that as the starting point for my Presentation.  So I’m going to Pause the demonstration for a 

moment and what I’m going to do is Open up the Word Document that I want to use so I can 

show it to you and I’m also going to start a brand new empty PowerPoint Presentation so I can 

show you how it comes across.  So I will be back as soon I have made those changes. 

Alright, here is a Blank PowerPoint Presentation.  I could go through and I could impose all 

kinds of Themes on it.  We can select a Theme, and basically there is a Theme.  And we could 

use Templates.  Everything that we covered in the Template topic and the Theme topic is 

appropriate for starting a Presentation using the Importing of information Text from Word.  Now 

what I’m going to do is I’m going to flip over to Word and here I have a Document on Thinking 

Styles.  This is all about, and I won’t go into detail, but this is all about Dr. Roger Sperry and his 

left brain-right brain capability.  And what I want to do is use this information as the beginning 

point for a PowerPoint Presentation.  So what I’m going to do is I’m going to go and I have to 

Close this document because I have to be able to Import it.  And so therefore I go to Home.  I go 

to New Slide and I go Slides from an Outline, and basically I find this Thinking Styles Document 

and I go Insert.  And basically what it’s doing is, is that PowerPoint is Analyzing the Data in the 

Word Document and it has brought it across.  Now you’ll notice that in this particular Document 

there was a lot of points on one Slide and so therefore they were all put here.  The other thing 

you will notice is that this Slide has a huge amount of Text because one of the things about 

bringing Documents across from Word is that Word Headers cause the Creation of a Slide.  And 

in my Word Document I will Pause, Open up the Word Document, and I will show you because 

if you’re going to use Word Documents you really have to appreciate this. 

So, here I am back in my Word Document and you will notice that I had basically this is Heading 

1 and this is Heading 2.  So therefore I’m forcing all of this to in effect be two Slides.  So one of 

the things you want to be very careful of is if you have a Document in Word and you want to 
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bring it into PowerPoint, you need to understand Word and how the Document is organized.  The 

other thing you will notice is, is that since we brought it in an Outline Style all we brought across 

were the Headings.  We didn’t bring across the Text and we didn’t bring across the Graphics.  So 

simply taking a fully developed Word Document and bringing it across is not nearly as effective 

as Cutting and Pasting.  We could actually Cut and Paste and I’ll just show you one example 

about this.  Here is this nice Document about left brain-right brain and so what we could do is we 

could Copy and then we could go to our PowerPoint Presentation.  I’ll just put in a New Slide 

and I will go to Paste and there I have Pasted.  So you if the Word Document is Outlined without 

Headers it really works effectively to bring across.  But if it is a Word Document that has been 

Formatted then you are better off to simply Cut and Paste what you need.  But basically Cutting 

and Pasting is still a very effective way to Share information between Word and PowerPoint. 
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Chapter 5 – Presenting Presentations 

Video:  Introduction to Presenting Your Presentation 

 
James:  This chapter, Presenting Presentations, has the following topics:  Using PowerPoint 

Notes feature, Creating Handouts, Printing, Automated or Self-Running Slide Shows, how to 

Create them, and lastly how you can use PowerPoint to actually Annotate a Presentation as 

you’re presenting. 
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Video:  Using Notes 

 
James:  Using the Notes feature in PowerPoint 2010.  Notes are explanations or Comments 

added by the Creator below the actual Slide.  They’re not displayed in the Slide Show View or 

Reading View.  You, for example, don’t know whether there is half a page of Notes or there are 

no page of Notes associated with this particular Slide.  We’re going to in this Presentation talk 

about Notes for the presenter only.  In that case, you will Print them and Review them before the 

Presentation or actually use them during the Presentation as a script.  There is an 

environmentally friendlier way of approaching it and that is, is that PowerPoint 2010 supports 

dual monitor Presentations.  And that is, is that you have the Slide Show on one and the Notes on 

another monitor and so we will talk about that as well.  Let me demonstrate. 

We can Create Notes about the Content of our Slides using the Note portion of the Slide Pane of 

the Normal Slide View.  And we can say “This is a Note”.  This works very effectively if we 

have very short, very brief, and very precise Notes.  We could also use it to Edit Notes after we 

have Created them.  But if you’re going to Create large Notes and you want to Format them and 

Edit them easily, there is a special View that PowerPoint presents and that is we select the View 

Tab, the Presentations Group, and we select the Notes Page.  And basically what this does is this 

gives us a display of our Slide at the top, our Note at the bottom. And we can change the Zoom 

factor so it becomes a little easier to see our Note.  And we can go down here and say, “This is a 

second Note”, and we can enter Notes in this View.  Now the other thing that PowerPoint does is 

it allows us to Format the Notes area and the Header and Footer of the Notes Page. And to do 

that what we do is we simply go in the View Tab to the Master Views Group and we select the 

Notes Master.  And basically the first thing we can do is we can Format the Text.  So, for 

example, we could make it Bold, and for the second level we could make it Bold and we could 

add a Bullet.  So we can Format exactly the way we want our Notes to appear.  This is very 

useful if we’re going to use the Notes as a Handout.  The other portion of the Notes Page that we 

can work with is we can Format the Header and we can Format the Footer information.  So, for 

example, we can go up here and we can select Header, and we can make it Bold.  And we can 

say, “Effective Presentations”.  And we can go and we can Move it in a little bit so that it’s not 

right up against the Margins.  We can change the Format of the Date.  We can do that.  We can 

do the same thing for the Footer.  Now in the case of the Footer all I’m going to do is Format it at 
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this time because I’m going to show you in a moment or two that what we can do is actually 

enter the Footer information, or the Header information for that matter, as we want if we want a 

different one on each Slide.  So what we’ve done is we have now Formatted the Notes Master 

Page and what we do is when we’re finished we select the Notes Master Tab and we Close the 

Master View.  And we go down here and you’ll notice that our previous Notes are now Bolded, 

which is consistent with the way PowerPoint operates.  This is a third Note.  We want to Indent 

this one.  So we say, “This is a sub-point”.  And basically what we can do is we can go through 

and we can type our Notes.  Now in addition to using simply Text in our Notes, if we wish and 

again this is most effective when we’re going to use the Notes Page as a Handout, what we can 

then do is we can Insert into the Notes area of the Notes Page, we can Insert Pictures, ClipArt, or 

Screenshots.  I’m just going to illustrate this by selecting ClipArt and we will have some ClipArt 

and we can decide that we want a ClipArt to go here.  And you’ll notice that if we Grab the 

whole Notes area it Moves, and so what we do is we just want to Move the little cartoon that 

we’ve entered and so we do that.  And basically we can then go back in here and we can go and 

go, “This is another Note”.  So we have the capability to Insert Pictures, ClipArt, and 

Screenshots into our Note Pages.  Now what I want to do now is to illustrate to you what 

happens when you create large Notes.  And to do this what I’m going to do is I’m going to 

switch to a Slide where I have already created a very large Note so I can illustrate exactly the 

issues that you have with large Notes in PowerPoint. 

This is a very large Note that explains how to Create Floating Text.  Now what happens when 

you Create very large Notes is PowerPoint keeps shrinking the Size of the Font so that the whole 

Note is going to fit within the area designated for Notes at the bottom of the Note Page.  In fact, 

if I switch this particular Slide to Normal Slide View, you will notice that in the Normal Slide 

View the Note Text is Formatted and easily read.  It’s only when I go into the Notes Page that I 

see that I have a problem.  So if you’re going to Create large amounts of Text in your Notes it is 

strongly recommended that you do it in this View, so you can see what it’s going to look like 

when you actually Print the Note and give the Note to people as a Handout.   

I have now switched back to our standard original Slide with the Notes at the bottom.  And now I 

want to talk to you about adding Headers and Footers to the Notes Page.  You’ll remember 

previously that in the Notes Master Layout we Formatted and Created Headers and Footers, but 



Learn PowerPoint 2010 
 

© Copyright 2008-2012 Simon Sez IT, LLC. All Rights Reserved. 
 

now what we’re going to do is talk about actually displaying them on the page.  So what we’re 

going to do is we’re going to go to the Insert Tab to the Text Group and we’re going to go 

Header and Footer.  And you notice that the first thing is, is that we can include on the page the 

Date and Time or what we can do is we can have a Fixed Date and Time.  Automatically Update 

means that every time we Open the PowerPoint Presentation PowerPoint looks at the current date 

and replaces the Date with the standard date, the current date.  If we want the same Date, for 

example, the Date of the Presentation and we make it the 10
th

, we can do that.  You’ll notice that 

we entered the word Effective Presentations in the Master.  So we can display it.  We can turn on 

the Page Number and what we can do is we can enter the Footer here.  So we have a choice of 

entering the Footer and Header in the Layout or here, and we can go Apply to All and you’ll 

notice that it says Effective Presentations, and if we go down to the bottom it says James Bulmer.  

So therefore we can add Headers and Footers to our Note Pages.   

What I would like to do now is to share with you a tip or a trick for Notes Pages which are going 

to be used by the presenter to help them during the Presentation.  What I’m about to show you is 

not something that you want to do if you’re going to use the Notes Pages as a Handout to give to 

people. And what that is, is that you go down to the bottom of each Slide and what you do is 

when you get to the bottom, I personally always Move it to the right Margin and what I do is I 

type the Title of the next Slide.  So therefore, in this case, I’m on Slide 3, so I will go to Slide 4.  

I will see that it says “Who”.  We’re going to talk about who the Presentation is for and so I will 

go back to Slide 3 and down at the bottom I go WHO And I can add more words.  Now, the 

reason that this is very effective as a Notes for the presenter is, is that this allows you when you 

are talking about this particular Slide to very easily transition to the next Slide because you know 

what the Title of the next Slide is.  So you could be talking along about the Audience and then 

you could say, I would now like to talk exactly about who is the audience, and therefore you will 

be able to know what is in advance of the Presentation, looking at the bottom.  Some of the other 

things that you may want to consider to add; for example, is something like “26 Slides to go”.  If 

you’re doing a Presentation and you have a very precise time involved it’s very nice when you 

look down to know whether you have 36 Slides, 56 Slides, or 6 Slides left to go.  So what you do 

is, is that you actually go through and you can type how many Slides there are left to go.  These 

are simply tips based on experience.  
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The last thing I want to mention to you in this demo is that there is within PowerPoint 2010 the 

capability to do a Dual Monitor Presentation, and to do that what we do is we go to the Slide 

Show and we go to the Setup.  And you notice over here if we had two monitors we would be 

able to decide which monitor we wanted the Presentation to be on and which one we wanted the 

Slide Show to be on.  The other place we can do that is we have two monitors is we can go here 

and we can say Use the Presenter View and we can select which monitor.  In my case, I only 

have one monitor. But if you get in the situation where you have two monitors, remember you 

could actually project the Presentation on one monitor and use the Presenter View on another 

monitor and you will not need to have hard copy. 
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Video:  Creating Handouts 

 
James:  Creating Handouts.  Generally audiences want something to make notes on during a 

Presentation.  If there is not something tangible that people are given before the Presentation, a 

lot of them are going to spend time writing down the Slide Content and therefore do not hear the 

message.  Although you can Print the Note Pages, which were talked about and discussed in the 

previous topic in this chapter, this means that you must have Public Notes not talking points for 

yourself.  PowerPoint provides alternatives.  One alternative is to Print the Presentation one Slide 

per page, not very environmentally friendly, but certainly possible.  Or you can create 

Customized Handouts of your Presentation with 1, 2, 3, 4, 6, or 9 Slides on a page.  You then 

simply give these Handouts to your audience to follow along during your Presentation and to 

keep for future reference.  An alternative to the alternative is to create your Customized Handout 

and make it available electronically in advance and those people who want a hard copy can then 

Print it and bring the hard copy along with them.  Let me demonstrate. 

The Formatting of the Handout occurs using the View Tab, Master Views Group, Handout 

Master, and you will notice that, again, we have a one page display somewhat similar to the 

Notes, but in this case we simply have an Outline of where the actual Slides will occur.  We can 

see what it would look like with four Slides or two Slides or with six Slides.  We don’t have to 

spend a lot of time in the Handout Master making that decision because the ultimate decision 

will be made when we go to Print.  Whatever we setup here we can always override at Printing, 

which is a separate topic in this chapter.  The other thing to note is, is that PowerPoint assumes 

that we’re either going to use the Notes as a Handout or the Handout as a Handout and therefore 

it carries over the Header and Footer information that was created in the Notes Master to the 

Handout Master.  So what we can do is we can change it.  So we could, for example, take out My 

Name out of the Title and we can Format it, and we can go Home and we can make it Bold and 

we can make it large.  We could actually add Color, but if we’re going to Print a black and white 

Handout then adding Color doesn’t really add a lot.  So we’ll go back and go to the just a 

standard black and white. And we can Format the Date.  We can create a Footer.  I always pull 

them out so that they are not right up against the Margins.  And we could put any information we 

want.  Some people like to put Copyright information or Restrictions on the Handout in the 

Footer.  If we want to put a Copyright, for example, we can go Insert and we can go Symbol and 
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we can select the Copyright Symbol.  We can Insert it.  We can Close and then we can go and we 

could put as much information about Restrictions as we want.  And again what we can do is 

depending on how big we want the information to be, we can make it bigger or smaller.  And we 

have the same capabilities for Page Numbers here as we had for the Notes page.  So basically 

what we’ve done is we have Formatted our actual Handout Master.  To Close that we simply 

select the Handout Master Tab and click Close the Master View.  And then what we do is we go 

to the Insert Group, Insert Header and Footer, and in this Dialog we make sure that we select the 

Notes and Handouts Option.  And you’ll notice that this is where we actually go and decide 

exactly what we want to do.  Do we want an Automated Update for the Date?  Do we want the 

Header?  Do we want the Page Number?  Do we want the Footer?  And again we don’t worry 

about this, what it shows in the middle of the Preview, we just look at the top and the bottom.  

And when we are happy with what we want, we’re satisfied, we simply go to Apply All and now 

when we go to the Print topic and look at Printing the Handout we will be able to see the results. 
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Video:  Printing Presentations and Notes/Handouts 

 
James:  Printing.  You can Print your Presentation with or without Hidden Slides.  So if you 

want to Print the Presentation without Hidden Slides that is an option or you can include the 

Hidden Slides.  You can Print your Presentation in Outline Format.  This is especially powerful 

if you Outline a Presentation and you want somebody else to Review it and they want hard copy, 

then you can Print the Presentation in Outline Format.  You can Print your Presentation as Notes 

Pages or you can Print Presentation in Handout Format.  You can add Headers and Footers to 

any Printout.  These can be different for Slides or Notes and Handouts.  So you can have one set 

for Slides and a different set for Notes and Handouts.  Let me demonstrate. 

Printing is part of the Backstage, which we get at by selecting, clicking File and we then have 

Print and here are the Print Options.  Basically Printing in PowerPoint is very similar to Printing 

in any Microsoft Office Application.  What I’m going to do is focus on the specifics related to 

PowerPoint.  So, for example, we can determine which Slides we want to Print.  We can Print all 

the Slides.  We can Print the Current Slide.  We can Print a Custom Range.  If we had multiple 

Slides selected, we could Print just the selection.  I should mention that you will notice that we 

have the option here to Print Hidden Slides.  Hidden Slides are talked about in the Beyond Basics 

chapter Transitions topic.  Okay?  So we can Print Hidden Slides or not Print Hidden Slides 

depending on whether we want to have them given out or available in the Handout or not.  We 

can determine what we want to Print.  We can Print Full Page Slides, Note Pages, and you’ll 

notice that as we select the, what we want to Print, the View to the right changes.  This is where 

we Print the Outline View, which was covered in the chapter on Working with Slides, the 

Outlining topic.  So if we want to Print the Outline we simply select Print the Outline.  You’ll 

notice that in terms of Handouts, we have 1, 2, 3, and every time we make a choice it shows.  

You’ll notice that the three puts lines to the right so that people can make Comments on the 

Slides.  One of the things I should mention about Handouts is, is to carefully consider that you 

can put a lot of Slides on one page and the writing, the Text becomes so small that it’s very 

difficult to read.  I happen to be a person who wears glasses and if you gave me a Handout with 

six Slides per page I would have to stare if the Text is very small.  A lot of Organizations these 

days are recommending that they go with two Slides for Handouts.  The other thing is we can 

Frame the Slides.  If we want to have a Frame around the Slide we could do that.  We can Scale 
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to fit the paper and we can also Print with High Quality.  Down here it talks about Print the 

Comments and Ink Markups.  The whole subject of Comments, the creation of Comments, is 

covered in the Beyond Basics chapter, the Compare and Merge Presentations topic.  So if we 

have a Presentation that has Comments, we can Print them and we can also Print any Ink 

Markups.  We can determine whether we want to Collate.  This is only useful if we’re Printing 

more than one copy.  We can change the Orientation.  So, for example, we could change it if we 

wanted to, to a Landscape Orientation.  The last of these Options are we can Print in Color, as is 

shown here.  We can Print in Gray Scale or we can Print in pure Black and White.  Now you’re 

going to have to do some possibly some experimentation with your Presentation to determine 

whether Gray Scale is an effective way to go.  Pure Color or pure Black and White will work.  

The other thing that I should mention is, is that you can because you’re now looking at it, if for 

some reason you don’t like the Header and Footer, you have the option here of Editing the 

Header and Footer.  And I could put in some more information about Call for Help or whatever I 

want it to do.  And I could change the Header and Footer so I can actually have the Header and 

Footer I want on the Handout, in this case, that I’m going to Print or any one of my Printouts. 
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Video:  Automated Self-Running Slide Shows 

 
James:  Automated Self-Running Slide Shows.  This is the type of Presentation where you 

define the time each Slide will be visible before advancing to the next Slide.  There are two 

methods.  The simple method is to simply set a standard Time for each Slide.  This works well if 

each Slide has approximately the same Content and you have a limited number of Slides.  There 

is a much better method given to you by PowerPoint 2010.  And that is to Record and Save the 

Timings for each Slide.  So you develop your Presentation and then you go at the end and you go 

back and you look at each Slide and you Record and Save the Timings for each Slide in the 

Presentation.  You can also set these Presentations up to Loop until the Escape key is pressed.  

And this is great for Trade Shows and Conferences that Presentation just keeps running and 

running and running.  And if you want to stop it for any reason you just press the Escape key and 

you want to Start it again you just Start it and it keeps going.  The major issue in Automated 

Self-Running Presentations is Animation.  You cannot use the On Click to advance or the 

Presentation Stops the first time a Click is required.  I will show you that there are two solutions 

to this issue.  One of which is very simple and that is to Ignore Animation and the other is, is to 

set Animation up for Self-Running Presentations.  Let me demonstrate. 

Turning a completed Presentation into one that can, is Self-Running or on a fully Automated for 

use at a Trade Show or Conference uses, primarily, the Slide Show Tab, the Setup Group, and it 

starts with the Setup Slide Show Command.  And first of all we choose, you will notice that the 

Default is presented by speaker.  We can also Browse by individual, but the one that we’re 

interested in is Browse at a kiosk, and you’ll notice that when we select that the Loop 

Continuously until Escape is automatically turned on.  This means that the Presentation once 

started will continue running and when it gets to the end it will go back to the beginning until 

somebody comes along to the keyboard and actually presses Escape. We can Record a Narration, 

which I will show you in a minute, that will play when the show is running.  And if we have 

created a show with Animation what we can do is we can Remove the Animation and this is the 

quickest way to take and turn a Presentation with Animation into one that can be used at a Trade 

Show.  I will end this demonstration by showing you that there’s a way around this, but I will tell 

you now and I will stress later that it is a significant amount of work.  So we can say Without 

Animation.  And Manually or Use Timings if present.  We’re going to actually add Timings so 
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that the show version will advance automatically.  So we say OK.  And then what we do is at this 

point and time if all we want to do is setup the Timings for our Presentation, what we do is we 

simply go Rehearse Timings and you’ll notice that we have this Dialog Box appears in the upper 

left hand corner and what we can do is we can determine how long we want each of our screens 

to be displayed.  And when we’re happy that we have given people enough time to read our 

information what we do is we simply press and you’ll notice that we can Pause and think about 

it.  And so far we have gone for 27 seconds, and basically we can go through each one of these 

and it shows us the time on the Slide and the total time.  And so basically we do that.  When we 

get done what we do is we simply Close the Dialog.  We get the Message: Do we want to keep 

these times?  We can say Yes.  And basically you will notice that PowerPoint has switched us 

into Slide Sorter View where it shows the actual time on each Slide.  Now it is possible to Edit 

these times because what we can do is we can actually go to the Transition and we can say we 

want to go and have this to be only six seconds and you’ll notice that it goes and it is now six 

seconds.  And we can say that we don’t want to use the mouse click and we can go here and 

we’re happy with that.  So we can actually Edit the various Timings and we can go and we can 

give that one a little longer.  So we can go in and actually take our Rehearsed Times and actually 

Edit them as we think is best.  And then what we can do is to see the effect of that, to see what 

it’s going to look like when people come to the Trade Show and they’re looking at our 

Presentation, we simply go to Slide Show from the beginning and basically what happens now is 

we have the Presentation and at the appropriate point and time the first Slide leaves, the second 

Slide comes.  No Animation is there.  We’ve given people the time to read the Presentation.  

Every Slide will advance at the end.  It stays on the screen for the amount of time that we have 

indicated and basically if we went through the whole Presentation, at the end it would come back 

to the beginning and it would Loop back to the beginning and would start over again.   

Now, the other thing that we can do is we can Record from the beginning or Record from the 

Current.  And if we Record from the beginning, you will notice that we can decide what we want 

to Record.  The Slide and Animation Timings and this is where we can Record a Narration.  So 

basically, in this case, we would Record a Narration that would play overtop of the Slide Show 

that is being displayed in the kiosk.  I will leave this for you because that is takes a lot of work 

and you basically have to have a script and you have to walk through the way I’m doing in this 

training.  Now, the one thing that I do want to show you is that it is possible with some work to 
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actually create a Self-Running Presentation that uses Animation.  And so what I’m going to do is 

I’m going to go to Animation, I’m going to select the Slide Sorter View,  and here is the Current 

Animation displayed.  And you remember we talked about the whole subject of Animation in a 

separate topic in the chapter Beyond Basics.  So here is our Animation that we want to setup for 

the Slide Show.  So instead of using On Click, what we do is we say After Previous, and then we 

go down here and it says On Click.  Ah!  But in this case since it’s Self-Running if we do that 

then what we have to do is we would have to Click or turn off the actual Animation.  So what we 

do is we Convert that into After Previous and then we can say how long do we want to delay?  

And you’ll notice that it’s building us a Timeline.  And so what we do is we go down and say 

and build the Timeline.  And it takes a fair amount of work because we have to decide how long 

we want each one of these individual Objects to be on the screen.  And basically then we would 

go to the next Slide and again it starts After and we would do this.  I’m going to just select all of 

them and say After Previous and give them all a Timeline like that.  So now you go through and 

you have Animation in which there are No Slide Clicks.  So what we’re going to do now is go 

back to the beginning, Close the Animation Pane, go back to the Slide Show, go back to Setup 

the Slide Show, and say we want it with Animation, and what we do is we click OK and then we 

say From the beginning.  Now in this case, we at the end of each Slides Timings it’s going to 

advance and you will notice that I made this very quick, but basically you would have to work 

this out.  And that’s why I say it takes a considerable amount of time, but you will notice that we 

now have a Self-Running Presentation where the Slides advance and the Animation that we want 

is there. 
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Video:  Annotating While Presenting 

 
James:  In this topic, we’re going to talk about Annotating your Presentation while you’re 

actually doing the Presentation.  PowerPoint allows you when in Slide Show View to use a Pen 

Tool or a Highlighter.  The Highlighter so you can emphasize points on the fly.  You can add 

Lines and Circles to key concepts.  If you are presenting to get feedback you can Record the 

Comments on the Slides and Save the results.  So, for example, if there’s something in the 

Presentation the audience wants you to Remove, you can remember that by simply Drawing a 

Line through it as I have shown here.  When you leave the Slide Show View, you can keep the 

Annotation or Discard it.  So therefore if you want to you can keep all the changes that you 

Highlighted or all the information that you added with the Pen Tool in your Presentation.  Let me 

demonstrate. 

To the actual Presentation, there are a couple of Annotation adjustments that we can make.  To 

do that we go to the Slide Show Tab Setup Group, Setup the Slide Show, and if we have selected 

Presented by Speaker Full Screen then we can select the Pen Color.  And so if we don’t want to 

use that red we can use that.  We can also setup the Laser Pointer which is a capability that 

PowerPoint 2010 has to mimic the use of an external Laser by holding down the Control key and 

pressing the left most button.  So we make those changes.  Then we go into Slide Show and 

when we’re making our Presentation, what we can do is we can down at the bottom you will be 

able to see the Pen.  And if you select the Pen then it shows you, “Do you want to change the Pen 

or do you want to do the Highlighter?”  And what Ink Color do you want?  So we’ll start off 

simply with the Pen and basically what this does is this allows us to emphasize a point such as 

that.  And then what we do is we simply go back and we have the next one and the next one.  

And we’ll go to the next Slide, and what we want to do is Highlight the dissemination of 

information.  So we click the little Pen symbol.  We go to Highlighter and we Highlight.  Now, 

we can go back to the Arrow, which will advance the Presentation.  We can also get at that 

information by pressing the right mouse button.  And you’ll notice that we have the Pointer 

Options.  This is the Arrow, the Pen, the Highlighter, the Ink Color.  We can make Erasers.  We 

can change the Arrow Options.  The other thing that I should mention when I’m here because 

they indirectly relate to Annotation is, is that if we want to Pause our Presentation and Remove 

the information from the screen, basically what we can do is we can have a Black Screen, and 
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therefore we could have a discussion and our Slide would not be in front of people.  And 

basically to bring it back we simply press the Escape key.  So if we’re in a Presentation where 

there’s a lot of discussion going on and we want to Remove our Slide as the focus, basically 

what we can do is we can go, in this case we’ll do a White Screen, and basically when we want 

to go back to our Presentation we simply press the Escape key.  When we are finished with our 

Presentation, what we can do is we press Escape to end the Presentation.  We get this Message, it 

says, “Do you want to keep your Ink or Annotations?”  In this case, I will keep them so that I can 

show you what they look like, and basically you’ll notice that here is the Slide that we 

Highlighted.  And here is the Slide that we emphasized the, this particular point.  You need to 

practice with the Pen versus the Highlighter.  Some people try and use the Pen to write.  I 

personally have difficulty writing with the Pen and therefore you can’t read the results.  But 

basically, you can use the Pen for Highlighting or you can use the Highlighter for Highlighting 

and at the end of the Presentation you get to keep it so that you will have information on what 

was Annotated during the Presentation. 
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Chapter 6 – Conclusion 

Video:  Concluding the Course 

 
James:  I would like to conclude this training by sharing with you some of the benefits that I 

have found from good Presentations.  Probably the number one benefit of a good Presentation is 

it helps reduce misunderstanding, avoid confusion, inaccuracy, and also reduce the possibility of 

vagueness.  It allows the presenter to emphasize and reinforce key concepts.  Good Presentations 

stimulate thought and hold attention.  They decrease the audience resistance to change.  Some 

variety in a Presentation is good; too much is not good, it becomes a distraction.  Remember, the 

primary purpose of Presentations using PowerPoint is to assist the presenter’s verbal message.  

Specifically, focus on the idea being presented, build and maintain the idea, support the idea, add 

visual emphasis.  The danger of PowerPoint Presentations is their ability to deflect, confuse, and 

negate the verbal message, if the PowerPoint is not integrated in an effective manner.  I’m sure 

you have all heard the phrase Death by PowerPoint.  Death by PowerPoint is possible, but can be 

avoided with planning and a little extra work.  Thank you. 


